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 Note! 
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on page xi.

Seventh Edition (October 1998)
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releases and modifications until otherwise indicated in new editions.

Order publications through your IBM representative or the IBM branch office serving your locality. Publications are not stocked at the
address given below.
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IBM France
Centre d'Etudes et Recherches
Service 0798 - BP 79
06610 La Gaude
France

� FAX: (33) 4.93.24.77.97
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� IBM Internal Use: LGERCF AT LGEPROFS
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appropriate without incurring any obligation to you.

 Copyright International Business Machines Corporation 1996, 1998. All rights reserved.
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 Notices

References in this publication to IBM products, programs, or services do not imply
that IBM intends to make these available in all countries in which IBM operates.
Any reference to an IBM product, program, or service is not intended to state or
imply that only IBM's product, program, or service may be used. Any functionally
equivalent product, program, or service that does not infringe any of IBM's
intellectual property rights may be used instead of the IBM product, program, or
service. Evaluation and verification of operation in conjunction with other products,
except those expressly designated by IBM, is the user's responsibility.

IBM may have patents or pending patent applications covering subject matter in
this document. The furnishing of this document does not give you any license to
these patents. You can send license inquiries, in writing, to the IBM Director of
Licensing, IBM Corporation, 500 Columbus Avenue, Thornwood, New York 10594,
U.S.A.

 Product Page/Warranties
The following paragraph does not apply to the United Kingdom or to any
country where such provisions are inconsistent with local law.

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE WARRANTIES OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

Some states do not allow disclaimer of express or implied warranties in certain
transactions, therefore this statement may not apply to you.

Trademarks and Service Marks
The following terms, denoted by an asterisk (*), used in this publication, are
trademarks or service marks of IBM Corporation in the United States or other
countries:

AIX
APPN
ESCON
IBM
NetView
Operating System/2
OS/2
Personal System/2
PS/2
Presentation Manager
RS/6000
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About this Book

This book introduces and explains how to use the IBM* Controller Configuration
and Management (CCM) application to configure the resources used by an IBM
3746 Nways Multiprotocol Controller Model 900 or 950 for handling network traffic.

It provides instructions on how to navigate through the application windows and
provides a series of guidelines that are useful when configuring an IBM 3745 or
3746 communication controller for the first time.

The information in this book complements the online help.

Who Should Use this Book
This book has been written for anyone who uses the CCM to configure or manage
an IBM 3745 or 3746 communication controller and its associated resources.

How this Book is Organized
This guide is organized into parts:

Part 1, “Introducing the CCM”

This part introduces the CCM and:

� Explains the operating environments

� Gives some information about the user interface (menus and windows)

� Gives an overview of the configuration process

� Explains some of the configuration tasks that are generic, that is the tasks that
are available for the configuration of many or all of the data link control (DLC)
types.

Part 2, “Resource Configuration”

This part describes the configuration process and explains how to navigate through
the CCM to the windows where you configure your network resources. Each
chapter covers some of all the resources for a given DLC type.

Part 3, “Resource Management”

This part explains how to navigate to the windows where you manage APPN and
IP network resources by viewing operational information, and activating or
deactivating resources.

The bibliography, list of abbreviations, glossary, and index are at the back of this
book.
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Conventions Used in this Book
The following typographical conventions and graphics are used in this book:

Typeface Graphics Used for

Italics
Bold italics

Word emphasis

  
Bold Menu bar and drop-down menu choices

Pushbuttons
Field names
Window titles

  
Monospace � Text entered by user
  

 � Important notes

 Menu Conventions
This guide uses a short format to direct you to a particular menu choice. This
format does not distinguish between drop-down menus (from the menu bar) and
side-opening, cascaded menus; it only gives the chronological order of the menu
openings. For example, to go to the IP Static Routes  window used to configure IP
static routes:

Main window Configuration  menu → IP → Static routes  → IP Static Routes
window

This means:

1. To select the Configuration  drop-down menu from the CCM main window
menu bar

2. To select IP in the Configuration  drop-down menu

3. To select Static routes  in the IP cascade-menu to open the IP Static Routes
window.
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About the World Wide Web and the Year 2000

World Wide Web
You can access the latest news and information about IBM network products,
customer service and support via Internet at the URL:

http://www.networking.ibm.com

You can also directly access the 3746-9x0 technical support web site at the URL:

http://www.lagaude.ibm.com/3746pe

Year 2000 Statement
This product is Year 2000 ready. When used in accordance with its associated
documentation, it is capable of correctly processing, providing, and/or receiving
date data within and between the 20th and 21st centuries, provided all other
products (for example, software, hardware, and firmware) used with the product
properly exchange accurate date data with it.

For more information, refer to:

http://www.ibm.com/year2000
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Chapter 1. Welcome to the CCM

The IBM Communication Configuration and Management application (CCM) is
designed to help you configure and manage an IBM 3746 communication controller
and its associated network resources.

When you configure your controller and its resources, the CCM creates a
configuration file, referred to as the 3746 controller configuration file . Using the
CCM, you can create several configurations.

The CCM runs under the control of the OS/2* and features a Presentation
Manager* graphical user interface, where you can perform a wide range of tasks.

The CCM tasks are divided into two main categories:

Configuration  for defining configuration parameters such as coupler type, mode,
class of service, transmission group, and others. When a group of configuration
parameters has been defined, it can be saved to file on disk. This file can then be
immediately activated for use by the network, or it can be saved for later use.
Configuration parameters are defined by specifying values in CCM windows.

Management  that involves viewing operational information about the currently
defined network resources, and activating or deactivating network resources to
maintain optimal network performance. Tasks requesting network resource
information use commands that only specify the resource address.

Note:  This is a “how-to-find-it” guide that only shows a few, key windows that help
you go to a window used for specific configuration task; the actual window
used for the task is normally not shown in this guide.

For “how-to-configure” information, use:

� 3746 Communication Controller Models A, 3746 Nways Multiprotocol
Controller Models 900 and 950: Planning Guide, GA33-0457

� CCM online help.
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 Operating Environments
The CCM can be used on either:

� The service processor, where it is accessed via the MOSS-E. (The service
processor may be accessed via a Distributed Console Access Facility (DCAF)
remote console). This environment is referred to as the service processor
environment .

� A stand-alone workstation. This environment is referred to as the stand-alone
environment

Service Processor Environment
With the CCM installed and running on the service processor, you access it through
the MOSS-E user interface. In this type of installation, both the configuration and
the management functions can be used.

 Stand-Alone Environment
When the CCM is running in the stand-alone environment, the management part of
the application and the coupler with the 2080 address are not available for use
(they are ‘greyed-out’).

However the configuration part of the application is fully available for configuring the
controller and its resources before your machines arrive.

If several controllers are operating on the network, a good strategy is to configure
all controllers from a centralized location, using the stand-alone CCM. The
configurations can then be sent (exported) to each service processor when
complete.

Minimum Hardware and Software Requirements
The minimum requirements for workstations running the stand-alone version of the
CCM are:

� 80486 microprocessor or higher.

� 50 MB of hard disk space free.

 � VGA display.

Note:  The CCM windows are designed for a VGA resolution (640x480), higher
resolutions may cause minor column alignment problems. However, the MAE
configuration program will be easier to use because both of its window are
visible at the same time.

� 24 MB of virtual memory. The actual amount of virtual memory needed
depends on the size of the configuration (does it have tens of lines or hundreds
of lines).

 � Mouse.

� 3.5-inch diskette drive.

� IBM Operating System/2 (OS/2), version 2.1 or higher.
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 Installing CCM
This section explains the CCM driver levels and describes the MOSS-E and
stand-alone installation procedures.

 CCM Levels
This User's Guide is for the CCM functions in ECA 170, which are listed in
Table 1-1.

Table 1-1 (Page 1 of 2). Functions Supported by Each CCM Level

ECA Number

Microcode
EC Level
(See note 1)

CCM Version
(APPN BLPU
EC Level) Functions Supported

144
146

D22560A
D22560D

D22561
D22561

APPN configuration and
management

155 D46100 D22571

The above functions plus:

 � IP
� Frame relay over APPN

 � HPR/ANR
� IP configuration for ESCON

and token ring.

157
159
159

D46120
D46120A
D46120B

D46121
D46121.005
D46121.010

The above functions plus:

 � IP management
 � PPP
� Frame relay over IP

 � HPR/RTP
� Second expansion enclosure
� A CCM password

 � NetView Performance
Monitor (NPM).

167 D46130 D46131 000

The above functions plus:

� HRP/RTP and ARB on token
ring, Ethernet, SDLC, frame
relay, and ESCON

� APPN/ISR (5000 PUs + 15
000 sessions)

� Display of 3746 EC/ECA
microcode level

 � CDF-E checking

170
(See note 2)

D46130D D46131.024

The above functions plus:

� X.25 support on 3746 (under
NNP control)

� HPR MLTG on token ring,
SDLC, frame relay, and
ESCON

� BRS for 3746 PPP lines
� FRFH on 3746 lines
� CIR on 3746 frame-relay

lines.
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Additional, level-specific information is available in the README file that comes
with the stand-alone CCM.

Table 1-1 (Page 2 of 2). Functions Supported by Each CCM Level

ECA Number

Microcode
EC Level
(See note 1)

CCM Version
(APPN BLPU
EC Level) Functions Supported

175
(See note 2)

F12380 F12381.000

The above functions plus:

� APING function added (like
IP PING, but for APPN
traffic)

� ESCON adapter re-IML is
now optional when activating
a configuration

� Increased management of
remote IP addresses

� Make DLCI copies function
added

� IP access controls now
available at port level.

180 F12430 F12431.000

The above functions plus:

� Multiaccess enclosure (MAE)
configuration

� Management of MAE
configurations (import,
export, change coupler
number, and others)

185 F12720 F12721.000
IP route table filtering RIP V2
support

Notes: 

1. This is the minimum functional EC level as of the General Availability date of the
CCM level.

2. This ECA must not be ordered, the corresponding microcode is automatically
shipped with any features requiring this level. In particular, the 3746 Extended
Functions 1 (feature number 5800) must be ordered to operate any the functions
listed.

 3. Legend :

BLPU build logical program unit
EC engineering change
ECA engineering change announcement
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 Level compatibility

Different levels of CCM are upwardly compatible only. For this reason, a
configuration that has been generated at CCM one level can only be exported
to a CCM at the same or higher level.

When you display the configuration list, check the level compatibility column. It
indicates the CCM level with which a configuration is compatible. If this level is
different from the running CCM level, then the configuration is to be first
migrated before being opened (To know the running CCM level, select Product
Information  from the Help  pull-down menu). The migration is automatically
proposed when you want to open or activate the configuration. Once migrated,
the level compatibility for the migrated configuration changes to the running
CCM level. When there are several configurations, you can migrate them at the
same time.

IBM recommends that the same level of the CCM should be maintained in the
service processor and the stand-alone environment. This is important if
configurations generated on the stand-alone CCM are to be exported to a CCM
running in a service processor.

Details of the APPN BLPU level are displayed in the Product Information  window.

Viewing the CCM Product Information
You can view information about this release of the CCM: its version, EC (APPN
BLPU engineering change), and the date of general availability of this EC version.
To view the product information:

Main window Help  menu → Product information

Figure 1-1. Main Window Help Menu
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Installing CCM in Service Processor Environment
Installation of the CCM in the MOSS-E is a task which is performed by an IBM
customer engineer. The CCM is installed when the MOSS-E is installed.

Installing CCM in Stand-Alone Environment
The IBM customer engineer creates the CCM installation diskettes that you use for
installing the CCM.

Before installing CCM

Ensure that your workstation has the correct hardware and software
requirements (see page 1-2).

The installation procedure is in the README files that comes with the CCM and
may be different according to the level of the CCM that is being installed.

CCM Password Protection from MOSS-E
The CCM on a service processor can be protected by a password using the
MOSS-E CCM/Telnet User Profile Management  function in the Manage
Passwords  menu.

Starting the Service Processor CCM
To start the CCM in the service processor environment:

Step 1.  Open the MOSS-E 3746-9xx  group of menus.

Step 2.  In the 3746-9xx Network Node Processor Management  menu select
(→) the CCM-Controller Configuration and Management  function.

Starting the Stand-Alone CCM
Note:  When the CCM is running in the stand-alone environment, the management
part of the application and the 2048 coupler are not available for use (they are
'greyed-out').

To start the stand-alone CCM, you can use either the mouse or the keyboard.

Using the Mouse

Step 1.  Double-click on the CCM folder icon CCM

Step 2.  Double-click on the CCM icon 

3745
NN

CCM  to start the application.
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Using the Keyboard
Step 1.  Open an OS/2 window.

Step 2.  Type CCM and press Enter .

Stopping and Exiting from CCM
To stop the CCM:

Main window File  → Exit
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Becoming Familiar with the User Interface: the Main Window
The CCM provides a graphical user interface with which you will quickly become
familiar.

When you start the CCM, the main window is displayed (see Figure 1-2).

System Menu
Icon

Menu
Bar

(with Pull-Down Menus)

Information Area

Coupler
Address

Coupler
Icons

Second Expansion Enclosure
Row of Coupler Icons

First Expansion Enclosure
Row of Coupler Icons

Basic Enclosure
Row of Coupler Icons

A Selected
Coupler

Header Information

Figure 1-2. CCM Main Window

As shown in Figure 1-2, the main window includes the following features:

 � Menu bar
 � Header information
 � Coupler icons
 � Information area.

 Menu Bar
Five pull-down menus are available from the menu bar:

 � File
 � Configuration
 � Management
 � Options
 � Help.

 Header Information
The header information is dynamically updated, and shows the following:

� The active configuration (if one exists), not available in stand-alone CCM
� The opened configuration (if one has been opened)
� The opened reference CDF-E file (if one exists in the opened configuration).
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 Coupler Icons
The coupler icons represent a schematic view of the couplers in the basic
enclosure and expansion enclosures within the controller.

The lower row of coupler icons represents the 10 coupler slot addresses in the
basic enclosure, which can hold up top five adapters.

The middle row of coupler icons represents the 12 coupler slot addresses in the
first expansion enclosure, which can hold up to six adapters.

The upper row of coupler icons represents the 12 coupler slot addresses in the
second expansion enclosure, which can hold up top six adapters.

An adapter consists of one processor connected to one or two couplers: each
adapter has a pair of coupler icons. Adapters configured for ESCON* channels
only use one of a coupler pair.

The shape and color of the coupler icons give information about the couplers they
represent.

 Icon Shape
There are two shapes for the coupler icons:

Means that the coupler has been configured in the CCM.

Means that the coupler has not been configured in the CCM.

For example, if the first coupler configured on a processor is a TIC3, the
second slot on the processor is automatically labeled as an
unconfigured TIC3, since only a TIC3 can be installed in the second
slot.

In the same manner, if a LIC (LIC11 or LIC12) is configured on a
processor, the other slot is labeled as a LIC.

Blue and White Icons
These colors indicate the status of a coupler after a comparison has been made
between the actual, physical configuration of the coupler slot (as given in the
reference CDF-E file) and the CCM configuration of the coupler slot:

Blue Means that, when the CDF-E file was compared to the CCM
configuration file, no discrepancies were found between the two for that
coupler slot.

Note:  While a coupler is blue, its DLC type cannot be changed in the
CCM configuration unless it is “cleared”, refer to “Setting or Clearing the
Coupler Type” on page 3-10.

White Means one of the following:

� The reference CDF-E/CCM configuration comparison has not been
made

� During the comparison, the CCM coupler DLC type was not  found
in the reference CDF-E file.
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� During the comparison, the CCM coupler DLC type was  found in the
reference CDF-E file, but there are configuration discrepancies that
would prevent the coupler from operating properly.

 Grey Icons

Means that the coupler can be neither selected nor configured because
it is the:

� Second, unused slot in an ESCON adapter.

� 2048 slot, which is never available because of the amount of traffic
for the NNP and service processor handled by the 2080 TIC3
attached to the service LAN. The 2048 and 2080 slots are for
CBSP (type 2 or 3).

Note:  In the 3746-900, the 2048 is used to connect the 3745 to the
3746. This connection does not handle (route) a large amount of
traffic, most of it just passes through and is handled by other 3746
processors.

 Information Area
The information area is located at the bottom of the main window and displays
navigation and processing status information.

Working in the Main Window
This section briefly explains how to work with the coupler icons and the menus in
the main CCM window.

Working with the Main Window Menu Choices
In a stand-alone environment with no configuration currently opened, you can:

� Create a new configuration: File  menu → New
� Open an existing configuration: File  menu → Open
� Import a configuration: File  menu → Import

Note:   All choices on the Options  and Help  menus are also available.

Working with the Coupler Icons
Select a coupler icon to begin configuring a coupler. If you are using a mouse,
double-click on the icon for the coupler you want to configure. If you prefer to work
with the keyboard, use the arrow keys to highlight the desired coupler and press
Enter .

If the coupler type has already been defined, you go directly to the window needed
to continue the configuration process.

If the coupler type has not been defined, CCM opens the Coupler type  window,
where you must specify the coupler type. CCM then opens window needed to
continue the configuration process.

If the configuration is new, the first time you select a the coupler, CCM opens the
3745/3746 Parameters  window, where you must specify the 3746 model used and
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give information about the 3745 if a 3746 Model 900 is being used. CCM then
opens the Coupler type  window to continue the configuration process.

Working from the Pull-Down Menus
For some pull-down menu choices, you do not have to select a coupler icon,
instead just select the option from the menu. For example, any of the File
pull-down menu choices can be selected without first selecting a coupler icon.
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Chapter 2. About the Configuration Process

The CCM enables you to configure the controller and all the associated resources it
uses for handling network traffic.

An Easier Way to Configure
The CCM is designed to provide a much simpler method of configuring the
controller and its resources, when compared with the NCP generation process.

About 80% of the parameters have predefined default values. These values can be
used, or modified and saved as new default values if required. This saves time
and effort when several identical lines, ports, or stations are being configured.

Configuration files can also be copied or exported (or printed as listings). The CCM
ensures that the configuration is internally consistent by dynamically cross-checking
the validity of parameter values while you are entering them.

This dynamic checking allows CCM to help you, when you choose a value for a
parameter, by immediately disabling (greying-out) all the other CCM parameters
that are:

� No longer relevant to the configuration you are working on.

For example, if you start to configure an ESCON port for a SNA/subarea
network, the APPN and IP name parameters are greyed-out as they do not
apply to a SNA/subarea ESCON Channel.

� Automatically selected by the CCM and cannot be changed.

For example, for a serial line port, if you choose the DLC as SDLC, the network
parameter is automatically set to APPN and the set of choices is greyed-out.
But, if you choose the PPP DLC, the network is automatically set to IP and,
again, the set of choices is greyed-out.

During the configuration process, the CCM creates a set of output files which are
then compressed into a single file known as the 3746 configuration file (the .CCM
binary file, see Figure 2-1 on page 2-2).
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Figure 2-1. Files Created by the CCM during the Configuration Process

Legend:

.CMD 
Name: SNMP Definition File
Contents: SNMP definitions
Destination:  Network Node Processor (NNP)

.NDF 
Name: Network Definition File
Contents: APPN and IP resource configurations
Destination:  Network Node Processor (NNP)

.IDF 
Name: Internet Definition File
Contents: IP resource data
Destination:  Processors that handle IP traffic

.IOC 
Name: I/O Configuration Program file
Contents: Defines the ESCON channel paths
Destination:  Destination: Host (IOCP or the MVS Hardware Configuration

Definition (HCD) tool)

Note:  The CCM produces this file as output from a 3746
configuration file to be used as input for the host.

.NCP 
Name: Network Control Program (NCP) file
Contents: ESCON definitions for NCP
Destination:  Host (NCPGEN)

Note:  The CCM produces this file as output from a 3746
configuration file to be used as input for the host.

.ESC 
Name: ESCON Definition File
Contents: SNA/subarea, APPN, and IP ESCON definitions
Destination:  Used to configure ESCON processors

.CCM 
Name: CCM Configuration File
Contents: Complete CCM configuration (compressed) with all the above

files and others
Destination:  Hard disk that contains the CCM program
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.ACF 
Name: ASCII Configuration File
Contents: MAE resource configurations
Destination:  User: this is text version of MAE configuration.

What You Can Do with a CCM Configuration
With the CCM, configuration files can be created, modified, copied, imported,
exported, and activated as required.

Creating Configuration Files
Different configuration files can be created for different controller configurations and
environments (but only a single configuration file can be active at a given time).

You can create a configuration file in the service processor environment or in
stand-alone environment. This procedure is explained in “Creating a New
Configuration” on page 3-4.

Before starting the initial configuration  ensure you have available:

� The hardware configuration worksheets, which are located in the 3746
Communication Controller Models A, 3746 Nways Multiprotocol Controller
Models 900 and 950: Planning Guide, GA33-0457, and is used for keeping a
record the controller hardware topology, including details of coupler position
and type.

� The CCM parameter worksheets are also located in the 3746 Planning Guide
and are used for recording the configuration information for each controller and
its associated resources.

Modifying Configuration Files
If resources are changed (for example, if a coupler is added or a coupler is
replaced with one of a different type) the configuration file must also be updated.

This can be done in the service processor environment or in stand-alone
environment. This procedure is explained in “Opening and Modifying a
Configuration” on page 3-6.

After modifying a configuration, you can activate the changes in the configuration
either:

� Immediately, using the CCM Dynamic Configuration Update function on
individual ports and stations without disrupting the rest of the network. For
more information, refer to Chapter 14, “Dynamic Activation and How It Affects
Your Network” on page 14-1.

� Later, by activating the whole configuration, refer to “Activating a Configuration”
on page 3-7.

Before modifying a configuration  ensure that you:

� Know the file name of the configuration to be modified.

� Have the hardware configuration worksheet, if the hardware topology of the
machine has changed.
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� Have the parameter worksheets with the details of the changes to be made in
the configuration.

Copy a Configuration
You can make one or more copies of a given configuration by saving its file under
different names.

This is used, for example, if several controllers on the network have similar
configurations and a "master" configuration contains most of definitions needed by
all these controllers. This master configuration can be changed as needed for an
individual controller and saved under a unique name that corresponds to this
controller. This can be repeated for each of the other controllers, giving you a
group of configurations each customized for a specific controller.

This method can also be used to produce several configurations for the same
controller. For example, to handle traffic over a coupler differently at night, the
active configuration could change at 20:00 to the night version and change again at
07:00 to the day version.

Export/Import a Configuration
If you configure in the stand-alone environment, or in the service processor for a
controller not attached to the service processor, the configuration file must be
exported from the CCM to a diskette and then imported onto the service processor
hard disk of the destination controller using its CCM and MOSS-E.

You can also import a CCM configuration file for other than the default directory.
Refer to “Importing a CCM Configuration” on page 3-6.

Activate a Configuration
This must be done in the service processor environment CCM, refer to “Activating a
Configuration” on page 3-7.

A single configuration only can be active at a given time.

Configuring the Controller
To configure a controller, you define the parameters for the:

Controller itself:

� Controller frame information
� Its network focal point
� As a dependent LU requester (DLUR)
� Its mode of CCU operation (for a 3746-900)
� Class of service (COS) for its traffic

 � Communications protocol.

Controller resources:
The couplers.

To configure a coupler, you define parameters for its ports and stations.

The controller and its resources must be configured when they are first installed
and when modifications are made to the network.
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Configuration Creation in Different Environments
The procedure for creating a configuration depends on the environment in which
you are working (service processor or stand-alone).

Note:   In the following figures, the activation step has been included to show the
difference between the two environments.

In the Service Processor Environment
If you are using the service processor environment, follow the steps shown in
Figure 2-2.

Figure 2-2. Creating a Configuration in the Service Processor Environment
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In the Stand-Alone Environment
If you are using the stand-alone environment, follow the steps shown in Figure 2-3.

Figure 2-3. Creating a Configuration in a Stand-Alone Environment.
1Refer to “Configuring Station(s) on Coupler/Port 2080” on page 4-3.
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Chapter 3. Performing Generic Configuration Tasks

This chapter explains how to find the windows where you perform generic tasks
such as manipulating configurations and comparing coupler and port configurations
to the definitions in the CDF-E file.

A Word about the Buttons, Worksheets, and Online Help
The buttons Search , Copy , Save as Defaults , Modify  and Cancel  provide useful
functions when working with the CCM.

The parameter worksheets can be used during the pre-configuration planning to
note the values needed for the configuration(s). Once the CCM configuration
process is finished, these worksheets provide an easy-to-consult, permanent record
of the configuration. They should be kept up-to-date.

The CCM online help provides detailed information about the parameters, their valid
values, and the rules for their use.

The Generic Push Buttons

Copy Push Button
Use the Copy  button to make copies of a resource that is already configured.

Copying ports and stations that have previously been configured is a useful
time-saving feature when working with a configuration that contains many port and
station parameters.

For example, after configuring the first of 30 ports on a LIC11, you could
automatically make 29 copies and then modify them as needed.

To copy a port or station, you specify the number of ports or stations and up to four
common initial characters of the port or station names. The system then generates
a list of proposed new ports or stations with names that consist of the common
initial characters plus an incremented hexadecimal number.

The copies can be renamed and their currently configured values modified as
needed.

Search Push Button
Using the Search  button, you can find all the configured resources of a given type
that corresponding to search criteria that you define, such as the name, address,
comments, dial number, or MAC address.

Sort Push Button
Using the Sort  button, you can sort resources (such as OSPF or RIP IP addresses,
MLTGs, CDF-E couplers and ports) according to criteria that you define (DLC type,
port number, port name, dial circuit number, or IP address).
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Copying, Searching, and Sorting Resources
Table 3-1 shows which resources that can be copied, searched for, or sorted.

The changes made to a list using Modify  and Delete  are changed in the CCM
configuration after you click on OK.

Table 3-1. Copy, Search, and Sort Availability

Resource Function Available

Copy Search Sort

Port configurations:
LIC11 (Serial Line)

 
X

 
X

 

Station configurations:
LIC11 (Serial Line)
LIC12 (Serial Line)

 Token-Ring

 
X
X
X

 
X
X
X

 

MLTGs  X X

DLCIs X X  

IP configurations:
 OSPF addresses
 RIP addresses

  
X
X

 
X
X

Managing resources:
 Ports
 Stations
 Sessions

The CCP IP display

 X
X
X
X
X

 

CDF-E resources   X

Save as Defaults Push Button
Use the Save as defaults  button to save the current window parameter values as
the new default values in that window.

The new default values apply to all ports and stations of the current DLC type that
you configure later – each DLC type has its own default values.

All ports and stations configured before the defaults were changed use the original
default values. Before making major changes, you should carefully check the
proposed new defaults to avoid having to make time consuming corrections later.

Modify Push Button
Use the Modify  push button to change a parameter value. Enter the new value,
then press Modify  to save it.
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Cancel Push Button
Use the Cancel  button to exit the current window without saving any changes that
have been made to and through this window.

 Important... 

When using the Cancel  button, be careful as the system does not
request confirmation. Not only is any modified information lost in the
current window, any changes to any other windows that you have
accessed via the current window  are lost.

Note:  If you have used the Save as defaults  button anywhere, the
new default values are not lost  when Cancel  is used.

Getting Online Help
If you need additional information while using the CCM, use the online help by:

� Clicking on the Help  button at the bottom of the window.

The global help for the current window is displayed; it provides information
about the window controls (buttons, lists, and so on) and parameters (values,
ranges, and rules for use).

� Selecting a parameter in the window and pressing the F1 key .

The contextual help for the parameter (value, range, and rules for use) is
displayed.
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Generic Configuration Tasks
The following tasks are not related to any specific DLC type.

Creating a New Configuration
To create a new configuration:

Step 1.  Main window File  menu → New

Step 2.  In the Configuration Description  window, enter the configuration file
name and a short description in the Comment  field.

Step 3.  Press OK to return to the CCM main window.

Importing an ESCON Configuration
You can import an ESCON channel configuration output file (.SBS) from the
ESCON Generation Assistant. To import a .SBS file, you must create a new CCM
configuration.

To import an ESCON configuration:

Step 1.  Main window File  menu → New

Step 2.  In the Configuration Description  window, enter the configuration file
name and a short description in the Comment  field.

Step 3.  Select the Import ESCON SBS file created with EGA  checkbox.

Step 4.  Provide the full path information of the .SBS file, including the file name.

Step 5.  Press OK to import the .SBS file and return to the previous window.

Step 6.  Press OK to return to the main window.
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Viewing a List of Available Configurations
You can select a configuration and perform various tasks with it, such as activate,
delete, modify, or open it.

To view the list, main window File  menu → Open :

Figure 3-1. Main Window File Menu

Figure 3-2. Configurations List

  Chapter 3. Performing Generic Configuration Tasks 3-5



  
 

Importing a CCM Configuration
You can import a configuration into the CCM by selecting it from the list of available
configurations.

To import a configuration:

Step 1.  Main window File  menu → Import a configuration .

Step 2.  In the window Path Selection , specify the location of the file to be
imported and press OK.

Step 3.  In the Import a Configuration  window, select the required configuration
and press Import selected configuration  to confirm the importation.

Opening and Modifying a Configuration
To open and modify a configuration:

Step 1.  Main window File  menu → Open  (see Figure 3-1 on page 3-5)

Step 2.  From the configuration list, select the configuration you want to modify
(see Figure 3-2 on page 3-5).

 Important... 

When you select a configuration, check the level
compatibility column in order to know whether this
configuration is compatible with the running CCM level. If
the level indicated is different from the running CCM level,
the configuration is migrated before being opened or
activated. You are prompted to start the migration when
you try to open or activate such a configuration. After the
migration completion, the level compatibility for the
migrated configuration changes to the running CCM level.
If you have several configurations which are not compatible
with the running CCM level, you can migrate these
configurations at the same time (See “Migrating
Configurations” on page 3-7).

To check the running CCM level, select Product
Information  from the Help  pull-down menu.

Step 3.  When the configuration opened, modify it as required, refer to Part 2,
“Resource Configuration.”

Step 4.  When completed: Main window File  menu → Save

Note:  If you were only viewing the configuration, you can close it without
modification: Main window File  menu → Close opened configuration
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Saving a Configuration to Diskette or Hard Disk
You can export a configuration in the:

Stand-alone environment
To the A: or B: drive or any accessible hard disk partition.

Service processor environment
Only to the A: drive.

To export a configuration:

Step 1.  Main window File  menu → Open

Step 2.  In the configuration list, select the configuration to export and press
Export  (see Figure 3-1 on page 3-5).

Step 3.  In the Path Selection  window, specify the destination disk and press OK.

Activating a Configuration
To activate a configuration:

Step 1.  Main window File  menu → Open

Step 2.  In the configuration list, select the configuration you want and press
Activate  (see Figure 3-1 on page 3-5).

Note:  A configuration cannot be activated if it is currently opened.

 Migrating Configurations
When you have several configurations which are not compatible with the running
CCM level, you can decide to migrate these configurations at the same time. In
order to know if a configuration is compatible with the running CCM level, check the
level compatibility column. If it indicates a level different from the running one, the
configuration must be migrated. To migrate configurations:

Step 1.  Main window File  menu → Open

Step 2.  In the configuration list, select the configurations that require migration
and press Migrate

Moving the MAE Coupler Connection
In the main CCM window, if you select the coupler configured for the MAE
connection and then click on the right mouse button, the pop-up contextual menu
allows you to go to the Move MAE configuration  function to change the MAE
coupler. Since not all unused couplers cannot be connected to the MAE, this
function only offers you the choice of the couplers that are available.
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Working with the CDF-E
The Reference CDF-E  menu (see Figure 3-3) lets you compare the opened CCM
configuration to a MOSS-E reference CDF-E (configuration definition file-extended).

For example, you may want to compare the active CDF-E of a 3746 with a CCM
configuration that you are planning to use in the 3746. This function allows you to
compare the machine hardware with the future machine configuration off line . This
allows you to check for and resolve any discrepancies between the hardware
configuration (as given in the reference CDF-E file) and the logical configuration
(the CCM configuration file) before activating the CCM configuration.

Figure 3-3. Reference CDF-E Comparison Menu
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Comparing Couplers and Ports in a Configuration with a Reference
CDF-E

To compare the couplers and ports in a CCM configuration with a MOSS-E
reference CDF-E:

Main window Options  → Reference CDF-E  → Compare with CCM configuration
→ CCM Configuration/Reference CDF-E Comparison  window (see Figure 3-4)

Figure 3-4. CCM Configuration/Reference CDF-E Comparison Window

Notes:

1. After the comparison is finished, some of the coupler icon are blue, others
remain white. For more information, refer to “Blue and White Icons” on
page 1-9.

2. If discrepancies are found between the CCM configuration and the reference
CDF-E, a message is displayed. Additional information about the discrepancies
can be found in the CCM log file.

3. As the MAE is not in the CDF-E file, none of buttons in this window are
enabled when the MAE is selected in the CCM column. However, the coupler
location of the MAE can be changed, refer to “Moving the MAE Coupler
Connection” on page 3-7.

Working with CDF-E Ports
By selecting a LIC11 in the CCM column (see Figure 3-4) and then clicking on the
Ports  button, you can see the results of the port comparison in the CCM
Configuration/Reference CDF-E Ports Comparison  window.

The ports can be sorted, swapped, and deleted to resolve discrepancies in the
same way as the couplers can be in Figure 3-4.
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Swapping Couplers or Ports
To swap two couplers (or ports), select the two couplers in the CCM configuration
and click on Swap .

If the attempted swap is not allowed, does not resolve, or creates a problem, a
message is displayed that saying that you cannot make the swap.

Deleting Couplers or Ports
To delete a coupler (or port), select it in the CCM column and click on Delete .
More than one coupler (or port) can be selected at the same time for deleting.

Sorting the Information in a CDF-E Comparison
You can sort the information in a coupler or port CDF-E comparison by status,
CDF-E, coupler, or CCM configuration.

To sort a comparison:

Step 1.  When the coupler or port list is displayed (see Figure 3-4 on page 3-9),
press Sort

Step 2.  In the Sort By  window, enter the sort criteria and press Sort .

 Problem Resolution
You can try to resolve any problems by swapping or deleting couplers or ports in
the CCM configuration to obtain either OK or Not configured  in the Status  column
for all the couplers.

If all the problems cannot be resolved by swapping or deleting, you must return to
the main window and re-configure one or more of the couplers.

Note:  None of the changes you make to the CCM configuration are saved until
you click on the OK button.

Setting or Clearing the Coupler Type
Once a reference CDF-E - CCM configuration has been made, the “blue” coupler
types are set. There are two ways to change the coupler type once they are set by
the CDF-E:

� To free (clear) all the “blue” couplers: Main window Options  →
Reference CDF-E  → Set/clear coupler type

You can reset the couplers again by selecting Set/clear coupler type  again.

� To free (clear) one “blue” coupler:

Click on the coupler you want to change with the right mouse button → Pop-Up
menu → Set/clear coupler type

You can reset the coupler by using Set/clear coupler type  again.
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Loading a CDF-E
To load a reference CDF-E into the opened CCM configuration:

Main window Options  → Reference CDF-E  → Import/load  (see Figure 3-3 on
page 3-8)

The disk that the reference CDF-E file can be loaded from varies according to the
CCM environment:

Service Processor
The reference CDF-E can come directly from the MOSS-E disk or from
the drive A.

Stand-alone
The reference CDF-E can come from the hard drive, the drive A, or
another .CCM configuration file.

The reference CDF-E loaded into the CCM configuration becomes part of the CCM
configuration when the .CCM configuration file is saved.
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Working with the CCM Files from a Remote Workstation
If you want to modify the active CCM configuration file, use the file transfer facility
available either through DCAF or Console for Java application1 in order to:

1. Download the required file from the service processor hard disk onto the
remote controlling workstation.

2. Upload the file onto the service processor hard disk, after modifying it.

File Transfer Major Steps
During the CCM configuration file transfer, three major steps take place as shown
in Figure 3-5 on page 3-13.

The first step takes place when you download
the configuration file from the service
processor hard disk (Q:\NODE\ MOSSE\
directory) to the remote workstation hard disk
(\CCMIN\ directory)

in Figure 3-5

  
The second step takes place when you
modify the configuration using a stand-alone
CCM. After modifying and saving the
configuration, you export the configuration to
the \CCMOUT\ directory.

in Figure 3-5

  
The third step takes place when you upload
the configuration from the remote workstation
hard disk (\CCMOUT\ directory) to the service
processor hard disk (Q:\NODE\MOSSE\
directory).

in Figure 3-5

1 If you are using Console for Java via an applet, you cannot  download and then upload files. You can only download  files from
the service processor.
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Figure 3-5. File Transfer Major Steps
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Before you go further...

� If you intend to use Console for Java program, it must be running on the
remote workstation. If you intend to use DCAF, DCAF must be correctly
configured and operational.

� You must be remotely connected to and controlling the service processor.
Refer to the Console Setup Guide for more information.

� You must know the name of the active configuration file. Otherwise, look
for it in the SCHEDULE.DAT  file, which is located on the service processor
hard disk in the Q:\NODE\ MOSSE\ directory.

� Two directories must be created on the remote controlling workstation:

– The \CCMIN\ directory where to download the CCM configuration file(s).
– The \CCMOUT\ directory where to export the CCM configuration file

after being modified.

If they were already created, check these directories are empty before
downloading any file. Otherwise, delete the files contained in them.

Using Console for Java Program
Step 1. In Console for Java, select Actions →File Manager . This displays the

File Manager  window. See Figure 3-6.

Step 2. From the Local  column, select the target directory, which should be
\CCMIN\2 . From the Remote  column, select the source CCM
configuration file from the Q:\NODE\MOSSE\ directory on the service
processor hard disk and double-click on it to copy it to the target
directory.

Figure 3-6. Console for Java File Manager Window

2 It is recommended to create one directory where to download the CCM configuration. For example, \CCMIN\.
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Step 3. Using the CCM stand-alone version, import the file from the \CCMIN\
directory (File→Import ).

Step 4. Open the file and modify it (File→Open ).

Step 5. Then save the configuration using a new name (File→Save as ).

 Important! 

 A CCM configuration is characterized by:

� The name you specify when you first create it or later modify it.
� The name of the file which contains the configuration data. This

name is automatically generated by CCM.

Each time, you modify a configuration, CCM changes the name of
the file which contains the configuration data.

Step 6. Close the configuration.

Step 7. Export the configuration to the \CCMOUT\3 directory (File→Open→
Select the configuration →Export ).

Step 8. Check that the modified configuration file has been exported to the
\CCMOUT\ directory.

Step 9. In Console for Java, select Actions →File Manager .

Step 10. In the File Manager  window, select from the Remote  column, the
Q:\NODE\MOSSE\ target directory on the service processor hard disk.
Then select the configuration file from \CCMOUT\ in the local  file list, and
double-click on it to copy it to the target directory.

Step 11. Use CCM (through the MOSS-E) in order to activate the modified
configuration.

Step 12. Once you no longer need to work with the CCM configuration files, delete
the files contained in the CCMIN and CCMOUT directories.

 Using DCAF
Step 1. From DCAF main window, select Services →Start File Transfer . This

displays the DCAF - File Transfer Utility  window (see Figure 3-7 on
page 3-16).

Step 2. In the Source file name  field, type in the source configuration name,
including the complete path, as follows:

Q:\NODE\MOSSE\xxxxxxxx.CCM, where xxxxxxxx  stand for digits.

Step 3. In the Destination file name  field, type in the target directory2 followed
by \.\. For example:

C:\CCMIN\\.\

Step 4. Press Receive .

3 It is recommended to create one directory where to export CCM configuration after modifying it and before uploading it back onto
the service processor hard disk. For example, \CCMOUT\.
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Figure 3-7. DCAF File Transfer Utility Window

Step 5. Using the CCM stand-alone version, import the file from the \CCMIN\
directory (File→Import ).

Step 6. Open the file and modify it (File→Open ).

Step 7. Save the configuration using a new name (File→Save as ).

See the  note on page 3-15.

Step 8. Close the configuration.

Step 9. Export the configuration to the \CCMOUT\3 directory (File→Open→
Select the configuration→Export ).

Step 10. Check that the modified configuration file has been exported to the
\CCMOUT\ directory.

Step 11. From DCAF main window, select Services →Start File Transfer .

Step 12. In the Source file name  field, type in the source configuration name,
including the complete path, as follows:

C:\CCMOUT\xxxxxxxx.CCM, where xxxxxxxx  stand for digits.

Step 13. In the Destination file name  field, type in target directory followed by
\.\. For example:

Q:\NODE\MOSSE\\.\

Step 14. Press Send .

Step 15. Use CCM (through the MOSS-E) in order to activate the modified
configuration.

Step 16. Once you no longer need to work with the CCM configuration files, delete
the files contained in the CCMIN and CCMOUT directories.

3-16 3746-9X0: CCM User's Guide  



  
 

 Part 2. Resource Configuration

 Copyright IBM Corp. 1996, 1998  



  
 

3746-9X0: CCM User's Guide  



  
 

Chapter 4. Beginning a CCM Configuration

Figure 4-1. Main CCM Window

If you are creating a new configuration...

If you are creating a new configuration and if you are configuring the first
coupler, go to step 1 on page 4-2.

Otherwise, go to step 4 on page 4-2.

Note:  To save a new configuration, at least the following two parameters must
have a value:

Network node: Network identifier  and Control point name

To go to these parameters: Main window Configuration  menu →
NN/FP/DLUR → Network Node/Focal Point/Dependent LU Requester
Parameters  window

It is possible to save a configuration with only these two parameters and the
name of the configuration file defined.

 Copyright IBM Corp. 1996, 1998  4-1



  
 

To start a new configuration:

Step 1.  Double-click on the icon for the coupler you want to configure. This
displays the 3745/3746 Parameters  window (see Figure 4-2).

Figure 4-2. 3745/3746 Parameters Window

Step 2.  Enter the parameters as required for your configuration.

 Note... 

If you leave the default 950 for the 3746 model , you will not be able
to add the 3745 identifier or set the mode of operation.

Information you have entered on some of the fields is retained by the
CCM. This information can be later modified by: Main window
Configuration  menu → 3745/3746 Parameters

Step 3.  When completed, click on OK → Coupler/Processor Type  window (see
Figure 4-3).

Figure 4-3. CCM Coupler/Processor Type Window

Step 4.  Select the desired coupler type.
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Step 5.  Click on OK → Port Configuration  window for the selected port type.

Step 6.  Go to the appropriate chapter:

� Chapter 5, “Configuring an ESCON Coupler”
� Chapter 6, “Configuring a Token-Ring Coupler”
� Chapter 7, “Configuring Serial Line SDLC Resources”
� Chapter 8, “Configuring Serial Line Frame-Relay Resources”
� Chapter 9, “Configuring Serial Line PPP Resources”
� Chapter 10, “Configuring Serial Line X.25 Resources”
� Chapter 11, “Configuring the MAE.”

Configuring Station(s) on Coupler/Port 2080
You specify the type of station(s) to be automatically generated on the 2080 port.
The station type depends on your use of the port:

 � Service Processor

– For a remote console using DCAF

– To use the Aping function

– To send alerts to NetView.

 � NPM

– Using NetView Performance Monitor

To configure these parameters:

Main window Configuration  menu → Stations on coupler/port 2080  → Stations
on Coupler/Port 2080  window (see Figure 4-4)

Figure 4-4. Stations on Coupler/Port 2080 Window
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Chapter 5. Configuring an ESCON Coupler

Before you start...

If this is the first coupler to be configured in a new CCM configuration, refer to
Chapter 4, “Beginning a CCM Configuration” on page 4-1

If this is the first time the coupler is to be configured, but it isn't the very first
one to be configured, double click on the icon of the coupler you want to
configure, choose its DLC type (see Figure 4-3 on page 4-2) , and go to
“Configuring the ESCON Port Parameters”  .

If the coupler type has already been defined, and if you want to just check or
modify the coupler configuration, double click on the icon of the coupler you
want to configure , and go to “Configuring the ESCON Port Parameters”  .

Configuring the ESCON Port Parameters
From the ESCON Port configuration  window (see Figure 5-1), you can specify
configuration parameters for ESCON ports and the ESCON Directors.

Figure 5-1. ESCON Port Configuration Window

Step 1.  Enter the parameters values as required. As you enter the values, CCM
dynamically checks them for configuration-wide consistency, refer to “An
Easier Way to Configure” on page 2-1.

An ESCON port can be shared by an APPN network, an IP network, and
an SNA/Subarea network.

If you want to configure IP access control filtering for this port, go to next
step.

Otherwise, go to Step 4 on page 5-2.
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Step 2.  Click on IP Access Control - Packet filtering  → IP Access Controls
window (see Figure 5-2).

Figure 5-2. IP Access Controls Window

Step 3.  When completed, click on OK.

Step 4.  When the port is completed, either click on OK to save and exit or click
on Host links  to display the ESCON Host Links Configuration  window.
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Configuring the ESCON Host Link Parameters

Figure 5-3. ESCON Host Link Configuration Window

Step 1.  Enter the parameters as required in the ESCON Host Link
Configuration  window (see Figure 5-3).

A host link can be shared by an APPN network, an IP network and an
SNA/Subarea network.

Step 2.  When completed, click on Add .

 Note... 

After clicking on Add , the host link information you have just entered,
is added to the Host Link Already Configured  list. Depending on
the type of host link configured, other push buttons are now available.

Step 3.  Repeat Step 1 and Step 2 for any other host links to be defined.

Otherwise, go to next step.

Step 4.  To configure the APPN parameters for one or more host links, go to step
5.

Otherwise, to configure ESCON stations for host links, go to “Configuring
ESCON Station Parameters” on page 5-4.

Configuring the Port APPN Parameters

Step 5.  Select a host link and click on APPN parameters  → ESCON Port
Configuration - APPN Parameters  window.

Step 6.  Keep the default APPN values or change them as needed.
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Step 7.  When completed, click on OK to return to the Host Links Configuration
window.

Step 8.  Repeat Step 5 on page 5-3 through Step 7 for any other host link that is
to be used for APPN.

Otherwise, go to “Configuring ESCON Station Parameters,” or click on
OK to save and exit.

Configuring ESCON Station Parameters
Step 1.  Select a host link and click on Stations  from the Host Links

Configuration  window → ESCON Station Configuration  window (see
Figure 5-4).

Figure 5-4. ESCON Station Configuration Window

Step 2.  Enter the parameters values as required. As you enter the values, CCM
dynamically checks them for configuration-wide consistency, refer to “An
Easier Way to Configure” on page 2-1.

A station cannot be shared by several networks. It is configured to work
in a single network.

If the station is defined for an IP network, the IP address must be
specified in this window (Figure 5-4).

Step 3.  Click on Add .

 Note... 

After clicking on Add , the station information you have just entered, is
added to the ESCON Stations Already Configured  list. Depending
on the type of station configured, other push buttons are now
available.
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Step 4.  Repeat Step 2 and Step 3 for any other station to be defined.

Otherwise, go to next step.

Step 5.  If you need to configure APPN parameters for one or several stations, go
to next step.

Otherwise, go to Step 13 on page 5-6.

Configuring the Station APPN Parameters

Step 6.  Select a station and click on APPN parameters  → ESCON Station
Configuration - APPN Parameters  window (see Figure 5-5).

Figure 5-5. ESCON Station Configuration - APPN Parameters Window

Step 7.  Either keep the default values or change these values according to your
needs.

Note:  For information about the MLTG, AOD, and DLUR parameters,
refer to:

� 3745 Communication Controller Models, 3746 Nways Multiprotocol
Controller Models 900 and 950: Planning Guide, GA33-0457

� CCM online help.

Step 8.  To configure the transmission group for this station, go to next step.

Otherwise, go to Step 12.

Step 9.  Click on TG characteristics  → Station Configuration - TG
characteristics  window.

Step 10.  Either keep the default values or change these values according to your
needs.

Step 11.  When completed, click on OK to save and return to the previous window.

Step 12.  When completed, click on OK to save and return to the ESCON Station
Configuration  window.
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Step 13.  To configure the DLC parameters for one or several stations, select a
station and click on DLC parameters  → ESCON Station - DLC
Parameters  window.

Otherwise, go to step 16.

Step 14.  Keep the default values, or change these values according to your needs.

Step 15.  When completed, click on OK to save, and return to the ESCON Station
Configuration  window.

Step 16.  Click on OK to return to the Host Links Configuration  window.

Step 17.  To configure ESCON stations for any other host link, repeat Step 1
(starting on page 5-4) through Step 16.

Otherwise, go to next step.

Step 18.  Click on OK on each window until the CCM main window is displayed.
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Chapter 6. Configuring a Token-Ring Coupler

Before you start...

If this is the first coupler to be configured in a new CCM configuration, refer to
Chapter 4, “Beginning a CCM Configuration” on page 4-1

If this is the first time the coupler is to be configured, but it isn't the very first
one to be configured, double click on the icon of the coupler you want to
configure, choose its DLC type (see Figure 4-3 on page 4-2) , and go to
“Configuring Token-Ring Ports”  .

If the coupler type has already been defined, and if you want to just check or
modify the coupler configuration, double click on the icon of the coupler you
want to configure , and go to “Configuring Token-Ring Ports” .

Configuring Token-Ring Ports

Figure 6-1. Token-Ring Port Configuration Window

Step 1.  Enter the parameters values as required in the Token-Ring
Configuration  window (see Figure 6-1). As you enter the values, CCM
dynamically checks them for configuration-wide consistency, refer to “An
Easier Way to Configure” on page 2-1.

A token-ring port can be shared between IP and APPN networks.

Note:  For information about using duplicate MAC addresses on two
ports for load balancing and TRP backup, refer to the 3746
Communication Controller Models A, 3746 Nways Multiprotocol Controller
Models 900 and 950: Planning Guide, GA33-0457.
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Step 2.  When completed, click on OK to save and exit. Otherwise:

� To configure the port APPN parameters, go to Step 3.
� To configure the IP parameters, go to Step 10 on page 6-3.
� To configure the port DLC parameters, go to Step 16 on page 6-3.
� To configure the connection network, go to Step 20 on page 6-4.
� To configure the stations, see “Configuring Token-Ring Stations” on

page 6-5.

Configuring Port APPN Parameters

Step 3.  Click on APPN parameters  → Token Ring Port Configuration - APPN
Parameters  window (see Figure 6-2).

Figure 6-2. Token-Ring Port Configuration - APPN Parameters Window

Step 4.  Keep the default parameter values, or change these values according to
your needs.

Step 5.  If you want to configure the user defined parameters, go to next step.

Otherwise, to Step 8.

Step 6.  Click on User defined parameters .

Note:  For information about the user defined parameters, refer to:

� 3745 Communication Controller Models, 3746 Nways Multiprotocol
Controller Models 900 and 950: Planning Guide, GA33-0457

� CCM online help.

Step 7.  When completed, click on OK.

Step 8.  Click on OK to return to the Token-Ring Port Configuration  dialog.

Step 9.  If you want to use IP over a token-ring port, go to next step.
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Otherwise, go to Step 19 on page 6-4.

Configuring Port IP Parameters

Step 10.  IP parameters  → IP over Token-Ring Parameters  window (see
Figure 6-3).

Figure 6-3. IP Over Token-Ring Parameters Window

Step 11.  Enter the IP address and the subnetwork mask values (note that up to 16
IP address and subnetwork mask pairs can be defined). Keep or change
the RIF timer default value according to your needs.

If you want to configure IP access control filtering for this port, go to next
step.

Otherwise, go to Step 14.

Step 12.  Click on IP Access Control - Packet filtering  → IP Access Controls
window (see Figure 5-2 on page 5-2).

Step 13.  When completed, click on OK.

Step 14.  When the IP configuration is completed, click on OK to return to the
Token-Ring Port Configuration .

Step 15.  If you want to configure the DLC port parameters, go to next step.

Otherwise, go to Step 19 on page 6-4.

Configuring Port DLC Parameters

Step 16.  Click on DLC defaults

Step 17.  Keep the default parameter values, or change these values according to
your needs.

Step 18.  When completed, click on OK to return to the Token-Ring Port
Configuration .
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Step 19.  If you want to configure port connection network parameters, go to next
step.

Otherwise, go to Step 25.

Configuring Port Connection Network Parameters

Step 20.  Connection network  → Token-Ring Connection Network  window (see
Figure 6-4).

Figure 6-4. Token-Ring Connection Network Window

Step 21.  Enter the Network identifier  and the CN name .

Step 22.  Click on Add CN .

 Note... 

After clicking on Add CN , the connection network that you have
just configured is added to the Connection Networks Already
Configured  list. Depending on the type of connection network
configured, other push buttons are now available.

After clicking on Add CN , you must click on Add port to CN ,
otherwise the connection network information you have just
entered will not be saved.

� If connection networks have been defined, select the one to which
you want to add the port currently being defined. A total of five
ports can be added to each connection network.

Step 23.  Click on Add port to CN .

Step 24.  When completed, click on OK to save and return to the previous panel.

Step 25.  If you want to define token-ring stations, go to “Configuring Token-Ring
Stations” on page 6-5.

Otherwise, click on OK to exit.
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Configuring Token-Ring Stations
 Note... 

Token-ring stations only need to be configured when the connection must be
established from the controller to the stations.

Step 1.  From the Token-Ring Port Configuration  window, click on Stations  to
display the Token-Ring Station Configuration  window (see Figure 6-5).

Figure 6-5. Token-Ring Station Configuration Window

Step 2.  Enter the parameters values as required. As you enter the values, CCM
dynamically checks them for configuration-wide consistency, refer to “An
Easier Way to Configure” on page 2-1.

Step 3.  Click on Add .

 Note... 

After clicking on Add , the station that you have just configured is
added to the Token-Ring Stations Already Configured  list.
Depending on the type of station configured, other push buttons are
now available.

Step 4.  If you need to configure APPN parameters for the station, go to next step.

Otherwise, go to Step 15 on page 6-7.
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Configuring Station APPN Parameters

Step 5.  Select a station and click on APPN parameters  → Token-Ring Station
Configuration – APPN Parameters  window (see Figure 6-6).

Figure 6-6. Token-Ring Station Configuration - APPN Parameters Window

Step 6.  Either keep the default values or change these values according to your
needs.

Note:  For information about the MLTG, AOD, and DLUR parameters,
refer to:

� 3745 Communication Controller Models, 3746 Nways Multiprotocol
Controller Models 900 and 950: Planning Guide, GA33-0457

� CCM online help.

If you want to configure remote LUs on adjacent nodes (if AOD has been
selected), go to next step.

Otherwise, go to Step 9.

Step 7.  Click on LUs... .

Step 8.  When completed, click on OK.

Step 9.  To configure the transmission group for this station, go to next step.

Otherwise, go to Step 13 on page 6-7.

Step 10.  Click on TG characteristics  → Station Configuration - TG
characteristics  window.
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Step 11.  Either keep the default values or change these values according to your
needs.

Note:  For information about the user defined parameters in the Station
Configuration - TG characteristics  window, refer to:

� 3745 Communication Controller Models, 3746 Nways Multiprotocol
Controller Models 900 and 950: Planning Guide, GA33-0457

� CCM online help.

Step 12.  When completed, click on OK to save and return to the previous window.

Step 13.  Click on OK to save and return to the Token-Ring Station
Configuration  window.

Step 14.  Repeat Step 5 on page 6-6 through 13 until you have configured the
APPN parameters for each station that requires APPN parameter
configuration, or go to next step.

Configuring Station DLC Parameters

Step 15.  To configure the DLC parameters for a station, DLC parameters  →
Token-Ring Station - DLC Parameters  window.

Otherwise, go to Step 18.

Step 16.  Keep the default values, or change these values according to your needs.

Step 17.  When completed, click on OK to save and return to the Token-Ring
Station Configuration  window.

Step 18.  Click on OK on each window until the CCM main window is displayed.
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Chapter 7. Configuring Serial Line SDLC Resources

This chapter concerns the configuration of serial line couplers LIC11 and LIC12 for
SDLC lines.

Before you start...

If this is the first coupler to be configured in a new CCM configuration, refer to
Chapter 4, “Beginning a CCM Configuration” on page 4-1

If this is the first time the coupler is to be configured, but it isn't the very first
one to be configured, double click on the icon of the coupler you want to
configure, choose its DLC type (see Figure 4-3 on page 4-2) , and go to
“Configuring the SDLC Port”  .

If the coupler type has already been defined, and if you want to just check or
modify the coupler configuration, double click on the icon of the coupler you
want to configure , and go to “Configuring the SDLC Port” .

Configuring the SDLC Port
Note:  A LIC12 has only one port, a LIC11 can have up to 30 ports.

Figure 7-1. Serial Line Port Configuration Window

Step 1.  In the Port Configuration  window (see Figure 7-1), select the DLC type
as SDLC and enter the other parameters values as required. As you
enter the values, CCM dynamically checks them for configuration-wide
consistency, refer to “An Easier Way to Configure” on page 2-1.
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Step 2.  When completed, click on Add .

 Note... 

After clicking on Add , the port you have just configured is added to
the Ports Already Configured  list. Depending on the type of port
configured, other push buttons are now available.

Step 3.  If you want to configure APPN parameters for a port, go to next step.

Otherwise, go to Step 10 

Configuring Port APPN Parameters

Step 4.  Select a port and click on APPN parameters  → Port Configuration -
APPN Parameters  window (see Figure 6-2 on page 6-2).

Step 5.  Keep the default values or modify these values according to your needs.

Step 6.  If you want to configure the user defined parameters, go to next step.

Otherwise, to Step 8 on page 6-2.

Step 7.  Click on User defined parameters .

Note:  For information about the user defined parameters, refer to:

� 3745 Communication Controller Models, 3746 Nways Multiprotocol
Controller Models 900 and 950: Planning Guide, GA33-0457

� CCM online help.

Step 8.  Click on OK.

Step 9.  When completed, click on OK to return to the previous window.

Step 10.  If you want to configure the DLC parameters for the port, go to next step.

Otherwise go to Step 15 on page 7-3.
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Configuring Port DLC Parameters

Step 11.  Click on DLC parameters  → SDLC Port - DLC Parameters 1/3  window.

Step 12.  Keep the default values or modify these values according to your needs
(see Figure 7-2).

Figure 7-2. The First DLC Port Parameters Window for SDLC

 Note... 

There are three windows containing the DLC port parameters, you can
display the second and third windows in any order.

Step 13.  When completed, click on OK to return to the previous window.

Note:  If the DLC Parameters 2/3  or DLC Parameters 3/3  window is
displayed, you must first return to the DLC Parameters 1/3  window, then
click on OK in that window to exit.

Step 14.  Repeat Step 1 on page 7-1 through Step 13 for any other ports that need
to be configured.

Step 15.  At this point, you can either:

� Save and exit port configuration by clicking on OK.

� Configure stations by going to “Configuring SDLC Stations” on
page 7-4.
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Configuring SDLC Stations
Step 1.  From the Port Configuration  window, select a port and click on APPN

Stations  → SDLC Station Configuration  window (see Figure 7-3).

Figure 7-3. SDLC Station Configuration Window

Step 2.  Enter the parameters as required and click on Add .

 Note... 

After clicking on Add , the station you have just configured, is added to
the SDLC Stations Already Configured  list. Depending on the type
of station configured, other push buttons are now available.

Step 3.  If you need to configure APPN parameters for the station, go to next step.

Otherwise, go to Step 13 on page 7-6
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Configuring Station APPN Parameters

Step 4.  Select a station and click on APPN parameters  to display the SDLC
Station Configuration – APPN Parameters  window (see Figure 6-6 on
page 6-6).

Step 5.  Either keep the default values or change these values according to your
needs.

Note:  For information about the MLTG, AOD, and DLUR parameters,
refer to:

� 3745 Communication Controller Models, 3746 Nways Multiprotocol
Controller Models 900 and 950: Planning Guide, GA33-0457

� CCM online help.

If you want to configure remote LUs on adjacent nodes (if AOD has been
selected),go to next step.

Otherwise, go to Step 8.

Step 6.  Click on LUs... → Adjacent Node - Remote LUs  window.

Step 7.  When completed, click on OK.

Step 8.  To configure the transmission group for the MLTG, go to next step.

Otherwise, go to Step 12.

Step 9.  Click on TG characteristics  → Station Configuration - TG
characteristics  window.

Step 10.  Either keep the default values or change these values according to your
needs.

Note:  For information about the user defined parameters in the Station
Configuration - TG characteristics  window, refer to:

� 3745 Communication Controller Models, 3746 Nways Multiprotocol
Controller Models 900 and 950: Planning Guide, GA33-0457

� CCM online help.

Step 11.  When completed, click on OK to save and return to the previous window.

Step 12.  When the APPN configuration is completed, click on OK to save and
return to the SDLC Station Configuration  window.
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Step 13.  To configure the DLC parameters for a station, select a station and click
on DLC parameters  → SDLC Station - DLC Parameters  window.

Otherwise, go to Step 17.

Figure 7-4. First SDLC Station Configuration - DLC Parameters Window

Step 14.  Keep the default values, or change these values according to your needs.

Step 15.  When completed, click on OK to save, and return to the SDLC Station
Configuration  window.

Note:  If the DLC Parameters 2/2  window is displayed, you must first
return to the DLC Parameters 1/2  window by clicking on OK or Cancel .

Step 16.  Repeat Step 1 on page 7-4 through Step 15 any other stations that need
to be configured.

Step 17.  Click on OK to return to the Port Configuration  window.

Step 18.  To configure stations on another port, select the port and go to
“Configuring SDLC Stations” on page 7-4.

Step 19.  If no other stations need to be defined, click on OK on each window until
the CCM main window is displayed.
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Chapter 8. Configuring Serial Line Frame-Relay Resources

This chapter concerns the configuration of the serial line couplers LIC11 and LIC12
for frame-relay lines. The frame-relay configuration procedure for defining the
DLCIs is different depending on your choice of bandwidth management (a DLC port
parameter) used:

� COMRATE (communications rate)

� CIR (committed information rate).

Before you start...

If this is the first coupler to be configured in a new CCM configuration, refer to
Chapter 4, “Beginning a CCM Configuration” on page 4-1

If this is the first time the coupler is to be configured, but it isn't the very first
one to be configured, double click on the icon of the coupler you want to
configure, choose its DLC type (see Figure 4-3 on page 4-2) , and go to
“Configuring a Frame Relay Port”  .

If the coupler type has already been defined, and if you want to just check or
modify the coupler configuration, double click on the icon of the coupler you
want to configure , and go to “Configuring a Frame Relay Port” .

Configuring a Frame Relay Port
Note:  A LIC12 has only one port, a LIC11 can have up to 30 ports.

Figure 8-1. Serial Line Port Configuration Window
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Step 1.  In the Port Configuration  window (see Figure 8-1 on page 8-1), select
the DLC type as Frame Relay  and enter the other parameters values as
required. As you enter the values, CCM dynamically checks them for
configuration-wide consistency, refer to “An Easier Way to Configure” on
page 2-1.

 Note... 

After clicking on Add , the port you have just configured is added to
the Ports Already Configured  list. Depending on the type of port
configured, other push buttons are now available.

For information about creating one or more ports identical to one in the
Ports Already Configured  list, refer to “Copy Push Button” on page 3-1.

Step 2.  If you want to configure APPN parameters for a port, go to next step.

Otherwise, go to Step 7.

Configuring Port APPN Parameters

Step 3.  Click on APPN parameters  → Frame Relay Port Configuration - APPN
Parameters  window (see Figure 6-2 on page 6-2).

Step 4.  Keep the default values or modify these values according to your needs.

Step 5.  Click on User defined parameters  if you want to define these
parameters at the port level.

Note:  For information about the user defined parameters, refer to:

� 3745 Communication Controller Models, 3746 Nways Multiprotocol
Controller Models 900 and 950: Planning Guide, GA33-0457

� CCM online help.

Otherwise, go to next step.

Step 6.  When completed, click on OK to return to the previous window.

Step 7.  If you want to configure the DLC parameters for a port, go to next step.

Otherwise go to Step 14 on page 8-3.
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Configuring the Port DLC Parameters

Step 8.  Click on DLC parameters  → Frame-Relay Port - DLC Parameters
window (see Figure 8-2).

Step 9.  Keep the default values or modify these values according to your needs.

In this window, you choose the type of bandwidth management
(COMRATE, the default, or CIR) to be used for all the traffic on this port.
This choice decides which window you use for configuring in “Defining
Frame-Relay DLCIs and Stations” on page 8-5.

Figure 8-2. Frame-Relay Port - DLC Parameters Window

Step 10.  Click on LMI to configure the frame-relay local management interface.

Step 11.  When completed, click on OK.

Step 12.  If CIR is selected as the Bandwidth management , click on CIR
Parameters  to configure CIR and CLLM parameters.

Step 13.  When completed, click on OK until you reach the Port Configuration
window.

Step 14.  If you want to configure IP over Frame Relay for the port, go to next step.

Otherwise go to step 19 on page 8-4.
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Step 15.  Click on IP parameters  → IP over Frame-Relay Parameters  window
(see Figure 8-3).

Figure 8-3. IP over Frame-Relay Parameters Window

Step 16.  Keep the default General  values or modify them according to your needs.

Enter the IP addresses that you want to use on this port.

If you want to configure IP access control filtering for this port, go to next
step.

Otherwise, go to Step 18.

Step 17.  Click on Access Control - Packet filtering  → IP Access Controls
window (see Figure 5-2 on page 5-2).

Step 18.  When the IP configuration is completed, click on OK to return to the
previous window.

Step 19.  When completed, you can either:

� Save and exit port configuration by clicking on OK.

� Configure stations by going to “Defining Frame-Relay DLCIs and
Stations” on page 8-5.
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Defining Frame-Relay DLCIs and Stations
In order to configure the stations, you must first define the DLCI(s) for the
frame-relay port. Then you define the stations for each DLCI.

Step 1.  Select a frame-relay port and click on DLCI.

Step 2.  If you configured the port for COMRATE bandwidth management, to
configure stations, go to next step (see Figure 8-2 on page 8-3).

Otherwise, go to Step 14 on page 8-6 to configure stations using CIR
bandwidth management.

Step 3.  In the Frame-Relay DLCI/COMRATE Parameters  window (see
Figure 8-4), for each DLCI you need keep the default values or modify
these values according to your needs and click on Add .

Figure 8-4. Frame-Relay DLCI/COMRATE Parameter Window

Step 4.  If you want to configure remote IP addresses for a DLCI, click on IP
addresses...  → DLCI Remote IP Addresses  window and go to next
step.

Otherwise, go to Step 7.

Step 5.  Enter the values according to your needs.

Step 6.  When completed, click on OK to return to the previous window.

Step 7.  If you want to change parameters for the FRFH, click on FRFH set  →
Frame-Relay Handler Set Configuration  window and go to next window.

Otherwise, go to Step 10 on page 8-6.

Step 8.  Keep the default values or modify these values according to your needs.

Step 9.  When completed, click on OK to return to the previous window.
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Step 10.  If you want to change the default DLCI communication rates (COMRATE)
for the APPN and IP stations, click on Default DLCI  → Frame-Relay
COMRATE - Default DLCI  window

Step 11.  Keep the default values or modify these values according to your needs.

Step 12.  When completed, click on OK to return to the previous window.

Step 13.  Go to Step 27 on page 8-7 

Step 14.  In the Frame-Relay DLCI/CIR Parameters  window (see Figure 8-5), for
each DLCI you need keep the default values or modify these values
according to your needs and click on Add .

Figure 8-5. Frame-Relay DLCI/CIR Parameters Window

Step 15.  If you want to configure remote IP addresses for a DLCI, click on IP
addresses... → DLCI Remote IP Addresses  window and go to next
step.

Otherwise, go to Step 18.

Step 16.  Enter the values according to your needs.

Step 17.  When completed, click on OK to return to the previous window.

Step 18.  If you want to configure BRS parameters for a selected DLCI, click on
BRS → Frame-Relay CIR - Bandwidth Reservation System (BRS)
window and go to next step.

Otherwise, go to Step 21 on page 8-7.

Step 19.  Keep the default values or modify these values according to your needs.

Step 20.  When completed, click on OK to return to the previous window.
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Step 21.  If you want to change parameters for the FRFH, click on FRFH set  →
Frame-Relay Handler Set Configuration  window and go to next step.

Otherwise, go to Step 24.

Step 22.  Keep the default values or modify these values according to your needs.

For more information about configuring a FRFH, refer to “Configuring
Frame-Relay Frame Handler Sets” on page 8-11.

Step 23.  When completed, click on OK to return to the previous window.

Step 24.  If you want to change the default DLCI committed information rate (CIR)
for the APPN and IP stations, click on Default DLCI  → Frame-Relay CIR
- Default DLCI  window and go to next window.

Otherwise, go to Step 27.

Step 25.  Keep the default values or modify these values according to your needs.

Step 26.  When completed, click on OK to return to the previous window.

Step 27.  Click on Add .

 Note... 

After clicking on Add , the DLCI information you have just entered, is
added to the DLCIs Already Configured  list. Depending on the type
of DLCI configured, other push buttons are now available.

Step 28.  Repeat Step 2 on page 8-5 through 27 for any other DLCIs to be defined
on the same frame-relay port.

Step 29.  If you want to configure APPN stations for a DLCI, go to “Configuring
APPN over Frame-Relay Stations” on page 8-8.

Otherwise, go to Step 23 on page 8-10.
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Configuring APPN over Frame-Relay Stations
Step 1.  Select a DLCI and click on APPN stations  → APPN over Frame Relay

– Station Configuration  Window (see Figure 8-6).

Figure 8-6. APPN over Frame Relay – Station Configuration Window

Step 2.  Enter the parameters as required.

Step 3.  Click on Add .

 Note... 

After clicking on Add , the station you have just configured, is added to
the Frame Relay Stations Already Configured  list. Depending on
the type of station configured, other push buttons are now available.

For information about creating one or more stations identical to one in the
Frame-Relay Stations Already Configured  list, refer to “Copy Push
Button” on page 3-1.

Step 4.  If you need to configure APPN parameters for the station, go to next step.

Otherwise, go to Step 15 on page 8-9

Configuring Station APPN Parameters

Step 5.  Select a station and click on APPN parameters  → Frame-Relay Station
Configuration – APPN Parameters  window (see Figure 6-6 on
page 6-6).

Step 6.  Either keep the default values or change these values according to your
needs.

If you want to configure remote LUs on adjacent nodes (if AOD has been
selected), go to next step.

Otherwise, go to Step 9 on page 8-9.
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Step 7.  Click on LUs... .

Step 8.  When completed, click on OK.

Step 9.  To configure the transmission group for the MLTG (including the user
defined parameters used to change route priority), go to next step.

Note:  For information about the MLTG, AOD, and DLUR parameters,
refer to:

� 3745 Communication Controller Models, 3746 Nways Multiprotocol
Controller Models 900 and 950: Planning Guide, GA33-0457

� CCM online help.

Otherwise, go to Step 13.

Step 10.  Click on TG characteristics  → Station Configuration - TG
characteristics  window.

Step 11.  Either keep the default values or change these values according to your
needs.

Note:  For information about the user defined parameters in the Station
Configuration - TG characteristics  window, refer to:

� 3745 Communication Controller Models, 3746 Nways Multiprotocol
Controller Models 900 and 950: Planning Guide, GA33-0457

� CCM online help.

Step 12.  When completed, click on OK to save and return to the previous window.

Step 13.  When completed, click on OK to save and return to the APPN Over
Frame-Relay – Station Configuration  window.

For information about creating one or more stations identical to one in the
Stations Already Configured  list, refer to “Copy Push Button” on
page 3-1.

Step 14.  If you need to configure DLC parameters for the station, go to next step.

Otherwise, go to Step 15 

Configuring Station DLC Parameters

Step 15.  To configure the DLC parameters for the station, click on DLC
parameters  → Frame-Relay/FRTE Station - DLC Parameters 1/2
window.

In this window, you can define, among others, the following parameters:

� Window increment (DYNWIND - nw)
� Window decrement (DYNWIND dwc)
� Discard eligibility (the conditions under which data are discarded).

Step 16.  Keep the default values or change these values according to your needs.

Step 17.  To configure more DLC parameters, click on DLC Parameters 2/2  and go
to next step.

Otherwise, go to Step 19 on page 8-10.

Step 18.  In the DLC Parameters 2/2  window, you can define, among others, the
following parameters:

 � Reply timer
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 � Acknowledgement timer
 � Inactivity timer
� Number of retries.

Step 19.  When completed, click on OK to save, and return to the APPN Over
Frame-Relay – Station Configuration  window.

Note:  If the DLC Parameters 2/2  window is displayed, you must first
return to the DLC Parameters 2/2  window, then click on OK in that
window to exit.

Step 20.  Repeat Steps 2 on page 8-8 through 19 for each station that needs to be
configured on the DLCI.

Step 21.  Click on OK to return to the Frame-Relay DLCI/COMRATE Parameters
or Frame-Relay DLCI/CIR Parameters  window.

Step 22.  To configure other station(s) on another DLCI, click on OK, and repeat
Steps 1 on page 8-8 through 21.

Step 23.  Click on OK on each window until the CCM main window is displayed.

8-10 3746-9X0: CCM User's Guide  



  
 

Configuring Frame-Relay Frame Handler Sets
You define the set name, NPA (NetView Performance Analyzer) eligibility, and the
primary-substitute partner DLCI pairing. You can also modify or delete sets in the
list of FRFH sets already configured.

To configure these parameters: Main window Configuration  menu →
Frame-relay frame handler set → Frame-Relay Frame Handler Set
Configuration  window (see Figure 8-7)

Figure 8-7. Frame-Relay Frame Handler Set Configuration Window

Only certain DLCI pairing possible in a given set. In general, the primary partner
DLCI can pair with each other or with one of the substitute DLCIs. The substitute
partner DLCI can never pair with each other. There are only four possible set
types. The combinations of pairing are:

1. A with B

2. A with B
A with D

3. A with B
A with D
B with C

4. A with B
B with C

Notes:

1. B is never paired with D.

2. For more information about a FRFH set configuration, refer to:

� 3745 Communication Controller Models, 3746 Nways Multiprotocol
Controller Models 900 and 950: Planning Guide, GA33-0457

� CCM online help.
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Chapter 9. Configuring Serial Line PPP Resources

This chapter concerns the configuration of serial line couplers LIC11s and LIC12s
for PPP leased lines.

Before you start...

If this is the first coupler to be configured in a new CCM configuration, refer to
Chapter 4, “Beginning a CCM Configuration” on page 4-1

If this is the first time the coupler is to be configured, but it isn't the very first
one to be configured, double click on the icon of the coupler you want to
configure, choose its DLC type (see Figure 4-3 on page 4-2) , and go to
“Configuring a PPP Port”  .

If the coupler type has already been defined, and if you want to just check or
modify the coupler configuration, double click on the icon of the coupler you
want to configure , and go to “Configuring a PPP Port” .

Configuring a PPP Port
Note:  A LIC12 has only one port, a LIC11 can have up to 30 ports.

Figure 9-1. Serial Line Port Configuration Window

Step 1.  In the Port Configuration  window (see Figure 9-1), select the DLC type
as PPP and enter the other parameters values as required.

As you enter the values, CCM dynamically checks them for
configuration-wide consistency, refer to “An Easier Way to Configure” on
page 2-1.

For information about creating one or more ports identical to one in the
Ports Already Configured  list, refer to “Copy Push Button” on page 3-1.
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Step 2.  Click on Add .

Step 3.  If you want to configure remote IP addresses for a DLCI, click on IP
addresses...  → DLCI Remote IP Addresses  window and go to next
step.

Otherwise, go to Step 6.

Step 4.  Enter the values according to your needs.

Step 5.  When completed, click on OK to return to the previous window.

Step 6.  If you want to configure the DLC parameters for a port, go to next step.

Otherwise go to step 15 on page 9-3.

Configuring the Port DLC Parameters

Step 7.  Select a port and press DLC parameters .

Step 8.  Keep the default values or modify these values according to your needs
(see Figure 9-2).

Figure 9-2. The First PPP Port Parameters Window

Step 9.  When completed, press OK to return to the Port Configuration  window
and go to Step 15 on page 9-3.

Otherwise, press Parameters 2/2  to define additional DLC parameters.

Step 10.  When completed, press OK to return to the PPP Port - Parameters 1/2
window.

Step 11.  To configure the bandwidth reservation class of the PPP port, press BRS
→ Bandwidth Reservation  window.

Step 12.  When completed, press OK to return to the PPP Port - Parameters 1/2
window.

Step 13.  Press OK to return to the Port Configuration  window.

Step 14.  Repeat Step 7 through Step 12 for any other ports that need DLC
parameters configured.
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Step 15.  Save and exit port configuration by pressing OK.
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Chapter 10. Configuring Serial Line X.25 Resources

This chapter describes the configuration of one X.25 port for a LIC11 or LIC12
serial line coupler.

Before you start...

If this is the first coupler to be configured in a new CCM configuration, refer to
Chapter 4, “Beginning a CCM Configuration” on page 4-1

If this is the first time the coupler is to be configured, but it isn't the very first
one to be configured, double click on the icon of the coupler you want to
configure, choose its DLC type (see Figure 4-3 on page 4-2) , and go to
“Configuring a X.25 Port”  .

If the coupler type has already been defined, and if you want to just check or
modify the coupler configuration, double click on the icon of the coupler you
want to configure , and go to “Configuring a X.25 Port” .

Configuring a X.25 Port
Note:  A LIC12 has only one port, a LIC11 can have up to 30 ports.

Figure 10-1. Serial Line Port Configuration Window

Step 1.  In the Port Configuration  window (see Figure 10-1), select X.25 as the
DLC type and enter the other parameters values as required. As you
enter the values, CCM dynamically checks them for configuration-wide
consistency, refer to “An Easier Way to Configure” on page 2-1.

Step 2.  Click on Add .
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 Note... 

After clicking on Add , the port you have just configured is added to
the Ports Already Configured  list. Depending on the type of port
configured, other push buttons are now available.

For information about creating one or more ports identical to one in the
Ports Already Configured  list, refer to “Copy Push Button” on page 3-1.

Step 3.  If you want to configure APPN parameters for the port, go to next step.

Otherwise, go to Step 8 

Configuring Port APPN Parameters

Step 4.  Select a port and click on APPN parameters  to go to the Port
Configuration - APPN Parameters  window (see Figure 6-2 on
page 6-2).

Step 5.  Keep the default values or modify these values according to your needs.

Step 6.  Click on User defined parameters  if you want to define these
parameters at the port level.

Note:  For information about the user defined parameters, refer to:

� 3745 Communication Controller Models, 3746 Nways Multiprotocol
Controller Models 900 and 950: Planning Guide, GA33-0457

� CCM online help.

Step 7.  When completed, click on OK to return to the previous window.

Step 8.  If you want to configure DLC parameters for the port, go to next step.

Note:  To configure stations on the X.25 port, you must define at least
two DLC parameters: the X.25 local DTE address  and one or more on
logical channel numbers (see Figure 10-3 on page 10-3).

Otherwise go to Step 18 on page 10-3.

Configuring the Port DLC Parameters

Step 9.  DLC parameters  → X.25 Port - DLC Parameters  window (see
Figure 10-2)

Figure 10-2. X.25 Port - DLC Parameters Window
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Step 10.  Keep the default values or modify the other values according to your
needs.

Step 11.  If you want to configure the LAPB parameters for the port, go to next
step.

Otherwise go to Step 15.

Step 12.  Click on LAPB parameters  → X.25 - LAPB Parameters  window

Step 13.  Keep the default values or modify the values according to your needs.

Step 14.  When completed, click on OK to return to the previous window.

Step 15.  PLP parameters  → PLP parameters 1/2  window (see Figure 10-3)

Figure 10-3. First X.25 PLP Parameters Window

Step 16.  You must enter values for the X.25 Local DTE Address  and for at least
one of the logical channel types: the PVCs values < Incoming SVCs
values < Two-Way SVCs  values < Outgoing SVCs  values.

Notes:

a. The SVC Highest  values must be always ≥ the Lowest  values.

Keep the other default values or modify them according to your
needs.

b. There is a second PLP parameter window available.

Step 17.  When completed, click on OK to return to the previous window.

Note:  If the PLP Parameters 2/2  window is displayed, you must first
return to the PLP Parameters 1/2  window, then click on OK in that
window to exit.

Step 18.  If you want to configure IP over X.25 for the port, go to next step.

Otherwise go to Step 24 on page 10-4.
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Step 19.  Click on IP parameters  → IP over X.25 - Port Parameters  window (see
Figure 10-4)

Figure 10-4. IP over X.25 - Port Parameters Window

Step 20.  Keep the default General  values or modify them according to your needs.

Enter the IP addresses that you want to use on this port.

If you want to configure IP access control filtering for this port, go to next
step.

Otherwise, go to Step 23.

Step 21.  Click on Access Control - Packet filtering  → IP Access Controls
window (see Figure 5-2 on page 5-2).

Step 22.  When completed, click on OK.

Step 23.  When the IP configuration is completed, click on OK to return to the
previous window.

Step 24.  At this point, you can either:

� Save and exit the port configuration by clicking on OK.

� Configure stations by going to “Configuring X.25 Stations” on
page 10-5.
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Configuring X.25 Stations
Before configuring stations on the X.25 port, you must define at least two DLC
parameters: the X.25 local DTE address  and one or more logical channel numbers
(see Figure 10-3 on page 10-3).

Step 1.  Click on APPN Stations  → X.25 Station Configuration  window (see
Figure 10-5).

Figure 10-5. X.25 Station Configuration Window

Step 2.  Enter the parameters as required and click on Add .

 Note... 

You must choose the type of virtual circuit (permanent or switched) for
the station. (It must have a logical circuit number [LCN] available, the
number of PVCs and SVCs are defined in Figure 10-3 on page 10-3.)

After clicking on Add , the station you have just configured, is added to
the X.25 Stations Already Configured  list. Depending on the type of
station configured, other pushbuttons are now available.

For information about creating one or more stations identical to one in the
Stations Already Configured  list, refer to “Copy Push Button” on
page 3-1.

Step 3.  If you need to configure the station DLC parameters, go to next step.

Otherwise, go to Step 7 on page 10-6.
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Configuring Station DLC Parameters

Step 4.  Click on DLC parameters  → X.25 Station - DLC Parameters  window
(see Figure 10-6) Otherwise, go to Step 21 on page 10-7.

Figure 10-6. X.25 Station Configuration - DLC Parameters Window

Step 5.  Keep the default values or change them according to your needs.

Step 6.  When completed, click on OK to save, and return to the X.25 Station
Configuration  window.

Step 7.  If you need to configure the APPN parameters, go to next step.

Otherwise, go to Step 17 on page 10-7 

Step 8.  APPN parameters  → X.25 Station Configuration – APPN Parameters
window (see Figure 6-6 on page 6-6)

Step 9.  Either keep the default values or change these values according to your
needs.

Note:  For information about the MLTG, AOD, and DLUR parameters,
refer to:

� 3745 Communication Controller Models, 3746 Nways Multiprotocol
Controller Models 900 and 950: Planning Guide, GA33-0457

� CCM online help.

If you want to configure remote LUs on adjacent nodes (if AOD has been
selected), go to next step.

Otherwise, go to Step 12.

Step 10.  Click on LUs... .

Step 11.  When completed, click on OK.

Step 12.  To configure the transmission group for the MLTG (including the user
defined parameters used to change route priority), go to next step.
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Otherwise, go to Step 16 on page 10-7.

Step 13.  Click on TG characteristics  → Station Configuration - TG
characteristics  window.

Step 14.  Either keep the default values or change these values according to your
needs.

Note:  For information about the user defined parameters in the Station
Configuration - TG characteristics  window, refer to:

� 3745 Communication Controller Models, 3746 Nways Multiprotocol
Controller Models 900 and 950: Planning Guide, GA33-0457

� CCM online help.

Step 15.  When completed, click on OK to save and return to the previous window.

Step 16.  When the APPN configuration is completed, click on OK to save and
return to the X.25 Station Configuration  window.

Step 17.  If you want to configure IP over X.25 for the station, go to next step.

Otherwise go to Step 24 on page 10-4.

Configuring IP Over X.25

Step 18.  Click on IP parameters  → IP over X.25 - Station Parameters  window
(see Figure 10-7)

Figure 10-7. IP over X.25 - Station Parameters Window. (This window is for a PVC, the
SVC window is slightly different.)

Step 19.  Keep the default General  values or modify them according to your needs.

Enter the IP addresses that you want to use on this station.

Step 20.  When completed, click on OK to return to the previous window.

Step 21.  Click on OK to return to the Station Configuration  window.
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Step 22.  To configure IP over X.25 for another station, select the station and return
to 18.

Step 23.  If other X.25 ports need to be defined for this coupler, return to
“Configuring a X.25 Port” on page 10-1.

Otherwise, click on OK until the CCM main window is displayed.
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Chapter 11. Configuring the MAE

This chapter describes how to use the MAE configuration program1 by including
some of the navigation features of the program.

Before you start...

If this is the first coupler to be configured in a new CCM configuration, refer to
Chapter 4, “Beginning a CCM Configuration” on page 4-1

If this is the first time the coupler is to be configured, but it isn't the very first
one to be configured, double click on the icon of the coupler you want to
configure, choose its DLC type (see Figure 4-3 on page 4-2) , and go to
“Understanding the Navigation and Configuration Windows”  .

If the coupler type has already been defined, and if you want to just check or
modify the coupler configuration, double click on the icon of the coupler you
want to configure , and go to “Understanding the Navigation and
Configuration Windows” .

Note:  Only one  MAE can be connected to a coupler per  CCM configuration. The
MAE can be connected to left-hand slot of any pair of unused  coupler slots. The
remaining, unused right-hand coupler slot is not available for configuration.

Understanding the Navigation and Configuration Windows
After CCM starts the MAE configuration program and clears the copyright notice, it
opens two windows:

� The full screen Configuration  window labeled “Nothing Selected!”. This is the
window where you actually configure each MAE resource. You use it most of
the time while configuring, so it is made as large as possible.

� The smaller Navigation  window (see Figure 11-1 on page 11-2). Use this
window to move through the MAE configuration program to find resources that
you want to view or configure. When the MAE Configurator starts, this window
is hidden by the Configuration window. There are two ways to bring the
Navigator Window  to the front when you need it:

– Click and hold down the left mouse key on the Configuration Window  title
bar then slide down the Configuration Window  until you can see the title
bar of the Navigator Window .

– Use the Ctrl + Esc  key combination to open the OS/2 task list and click on
Navigator Window .

– If you are using the stand-alone CCM, you can see both windows at the
same time if you increase your screen resolution above VGA-level.

You configure the MAE by selecting items in the Navigation window and then
providing details for each selected item in the Configuration window. When you

1 This program is also known as the IBM Nways Multiprotocol Access Services Configuration Program or the IBM 2210-400
Configuration Program.
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have completed entering the configuration details, select a new item in the
Navigation Window.

Using the MAE through the MOSS-E

MAE configuration windows are often larger than the service processor display
screen and the scroll bars are sometimes hidden. It is therefore highly
recommended  to change the screen resolution.

In order to enable a high-VGA screen resolution, select from the MOSS-E:

Service Processor Menu → Configuration Management → Service
Processor (SP) Customization → Screen Resolution . Then select the
600x800 option from the list.

The Navigation Window

Figure 11-1. Navigation Window

The Navigation window (see Figure 11-1) contains the following:

 � Menu bar

The Navigation window menu bar contains the following menus:

 – Configure

Use the Configure  menu option to exit the MAE configurator and return to
the 3746 resources.

 – Options

You can change the following configuration program options:

 - Colors
 - Message prompting

- ATM address format.
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 – Help

Note:  The following topics in the online help and tutorial do not apply to
the version of the MAE Configurator Program that is used with the CCM:

- Using the MAE Configurator from the command line
 - AIX support

- Configuration  menu functions
- Options  menu change fonts.

� Configuration description area

The area below the menu bar is the configuration description area. It displays
the following information:

– Scrollable list of features and protocols that you can configure.

This list is called the navigation list. As you select items in the navigation
list, the program displays related configuration panels in the Configuration
window.

If there are no configuration errors for a type of resource, a check mark (√)
appears next to that item in the navigation list.

If there is an error or if you have not supplied required information in the
current configuration, a question mark (?) appears next to that item in the
navigation list.

Contextual Pop-Up Menu
Another feature of the Navigation Window is a contextual pop-up menu that you
invoke by clicking the right mouse button on any selected folder in the navigation
list.

While holding down the right mouse button, drag the mouse to the submenu item
that you want to select. You can invoke the history pop-up from any item in the
navigation list in the same way you invoke the contextual pop-up menu.

The pop-up menu allows you to:

� Fully expand the navigation list.

� Expand a portion of a navigation folder.

� Contract a portion of the navigation list into a folder.

� Display the history of the configuration items that you have selected. From the
history pop-up you can access any of the previously selected configuration
items.

� Validate a selection item in error. The Navigation window marks erroneous
items with a yellow question mark.

The validate function displays messages for any configuration errors. Using the
validate function on a folder displays the validation messages for all of the
items within that folder.

After you correct an error and leave the configuration window that contained
the error, the question mark is removed.
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Return to the CCM
Use the Configure  menu option to exit the MAE configurator and return to the
3746 resources. If you have made changes in the MAE configuration, you are
asked if you want to save the changes before exiting. If so, click on Yes.

The Configuration Window
The title bar of the Configuration window (see Figure 11-2) identifies the item that
is selected in the navigation list.

As you select items in the Navigation window, the format of the Configuration
window changes to the appropriate display for the item selected.

Figure 11-2. Example Configuration Window
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MAE IP Access Control Packet Filtering

Figure 11-3. Access Control Packet Filtering Window

In Figure 11-3, five of the columns are used in special ways to configure the
interface selected in the list:

Configure (3rd column)
Click on the column heading to access the fields that let you to choose
input, output, or both types of packet filtering.

Input filter (4th column)
Click on the word enable or disable to toggle ON or OFF input filtering
for this interface.

Filter (5th column)
Click on the column heading to access several pages of fields used to
configure the input packet filters for this interface.

Output filter (6th column)
Click on the word enable or disable to toggle ON or OFF output filtering
for this interface.

Filter (7th column)
Click on the column heading to access several pages of fields used to
configure the output packet filters for this interface.

 APPN Interfaces

Figure 11-4. APPN Interfaces Window

In Figure 11-4, two of the columns are used in special In this configuration window,
four of the columns are used in special ways to configure the interface selected in
the list:

Configure (4rd column)
Click on the column heading to access several pages of fields used to
configure this interface.
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Link stations (5th column)
Click on the column heading to access several pages of fields used to
configure link stations for this interface.

Navigating Through the MAE Configuration Program
The MAE configuration program is designed with a point-and-click interface. In
addition to using a mouse pointer in the Configuration and Navigation windows,
various keys also have specific meanings.

Using the Mouse
The mouse pointer is the main tool you use to move through the various lists and
panels in the MAE configuration program.

The MAE configuration program uses the:

� Left button to select an item in a panel

� Right button to perform the following actions:

– In the Navigation window:

- Displays a pop-up menu for a selected item in the list
- Moves through and selects items in a pop-up menu
- Validates a selected item that was in error and has been corrected.

– In the Configuration window: drag-and-drop list items.

The configurator indicates that a drag-and-drop item is active by changing
the mouse cursor into a file icon. You can use drag-and-drop to reorder
many configuration lists.
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Using the Keyboard in the Configuration Program
Various keys have specific functions in the MAE configuration program, refer to
Table 11-1.

Table 11-1 (Page 1 of 2). Configuration Program Keyboard Functions

Key Function How to Use Key

F1 (Help) Request help

Note:  After you
press F1, the MAE
configuration
program displays a
frame that you use
to position the
window. Position
the frame wherever
you want on your
desktop and press
the left mouse
button to display
the help text.

� To obtain help for configuring a feature or protocol:

When the MAE configuration program displays a feature or
protocol configuration in the Configuration window, press
F1.

� To obtain help on a panel:

Step 1.  Select an item in the Navigation window.

Step 2.  Press F1.

� To obtain help on a parameter, a button, or a drop-down list:

Step 1.  Select the parameter field or button by tabbing to the
parameter field, button, or list.

When you tab to the field or button, a yellow box will
highlight the item.

Note:  You must use the tab key for help: clicking
on a button causes the MAE configuration program
to perform the configuration task indicated by that
button or drop-down list.

Step 2.  Press F1.

In the help text, additional information about certain words are
hypertext-linked to the help panel by clicking on the blue text.

If you press F1 on a different panel or parameter without closing a
previously opened help window, the new help text overlays the
currently displayed text.

In a help window, use:

� UP to view the previous topic

� DOWN to view the next topic

� CLOSE to close the help window.

Up and Down
Arrow Keys

Move vertically Use these keys to move through lists on any panel, including the
Navigation window and the drop-down menus. To select an item,
press the Enter key.

Left and Right
Arrow Keys

Move horizontally Use these keys to move through the menu items on the
Navigation window, after you have selected one of the menu
items. They can also be used to move through a parameter field
without affecting the existing values.

Tab and
Shift(Back)-tab

Next or previous
entry field

These keys work only in the Configuration windows to move
through the various entry items in a window.
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Table 11-1 (Page 2 of 2). Configuration Program Keyboard Functions

Key Function How to Use Key

Character Keys Speed-scroll Use character keys in the Navigation window to jump through the
list. When you type in a character, the selection marker moves to
the next item in the list that starts with the characters that you
have typed. This feature can help you change specific protocols
in a configuration without using the scroll bar to locate the
protocol. The following limitations exist:

� Speed-scroll works only in the Navigation window.

� Once you speed-scroll to an item, you must select that item
before speed-scrolling again.

Alt + C Configure
pull-down

Opens the Configure  menu.

Alt + P Options pull-down
menu

Opens the Options  menu.

Alt + H Help pull-down
menu

Opens the Help  menu.

Esc Escape Clears the pull-down menus.

Selecting Multiple Items in a List
Whenever the configuration program presents you with a selection list, you can pick
multiple items from those lists. The method for selecting items depends on whether
you want to start at one point and end at another point or just choose items at
random from the list:

To select items randomly:
Press and hold the Ctrl  key, point to each item and then press the left
mouse button.

To select a range of items:
Select the first item in the range. Press and hold the Shift  key. Select
the last item in the range and then press the left mouse button.

To de-select items
Press and hold the Ctrl  key, point to the item you want to de-select and
press the left mouse button. If you do not hold the Ctrl  key, you will
de-select all previously selected items except the item just selected.
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Chapter 12. Configuring IP Parameters

This chapter explains how to go to the windows where you configure the general
and default parameters of the IP parameters for Bootp, OSPF, RIP, BGP, ARP, and
SNMP.

Configuring General IP Parameters

Figure 12-1. IP Configuration Menu

General IP Parameters
You define parameters for direct broadcasting, packet multipathing, source routing,
and the routing table, cache and buffer sizes.

To configure these parameters: Main window Configuration  menu → IP →
General  → IP General Parameters  window

PPP NCP Default Parameters
You define retry and timeout parameters for configuration, NAK (negative
acknowledge character), and terminate.

To configure these parameters: Main window Configuration  menu → IP → PPP
NCP defaults  → PPP NCP Default Parameters  window
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IP Static Routes
You define parameters for destination network, destination mask, and next hop
address and cost. You can also modify or delete the records in the list of static
routes already configured.

To configure these parameters: Main window Configuration  menu → IP →
General  → IP Static Routes  window

IP Access Controls
You define access control filter parameters at the node-level for access control
type, source and destination address, protocol number and port. You can also
modify or delete the records in the list of access control entries already configured.

This filtering can also be done for several DLCs at the port-level by clicking on IP
access control - Packet filtering  in the Port Configuration  window.

To configure these parameters: Main window Configuration  menu → IP →
Access controls  → IP Access Controls  window

There is an example of the use of IP access controls on “Make Sure SNMP Access
is Enabled When Filtering Packets” on page 12-8.

 IP Filters
You define routing filter parameters for IP address and subnetwork mask. You can
also modify or delete the records in the list of IP filters already configured.

Note:  IP filters allow the control of host access to each other across a firewall.

To configure these parameters: Main window Configuration  menu → IP → Filters
→ IP Filters  window

IP Route Filters
When the route table filtering option is enabled and route filters defined, the system
checks the routes to be added to the IP routing table. Route table filtering can be
used in order to prevent the system from adding routes to the IP route table when
the network operator does not want all the routes advertised by routing protocols to
be available for use.

To enable route table filtering and/or define route table filters, Main window
Configuration  menu → IP → Filters  → IP Route Filters → IP Route Table
Filters  window

Bootp Forwarding Parameters
You enable Bootp and define parameters for maximum hops, waiting time before
forwarding and forwarding address. You can also modify or delete the records in
the list of Bootp forwarding server addresses already configured.

To configure these parameters: Main window Configuration  menu → IP →
Bootp forwarding  → Bootp Forwarding  window
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Configuring OSPF Parameters

Figure 12-2. OSPF Configuration Menu

OSPF General and Multicast Parameters
You can enable/disable the OSPF (Open Shortest Path First) and multicast
functions and define parameters such as number of routes/routers, and the group
addresses. You can also modify or delete the records in the list of group
addresses already configured.

To configure these parameters: Main window Configuration  menu → OSPF →
General/Multicast  → OSPF - General/Multicast Parameters  window

OSPF Parameters for each IP Address
You can select an IP address in the list and specify whether you want to configure
OSPF or RIP.

To configure these parameters:

Step 1.  Main window Configuration  menu → OSPF →
Parameters per IP address

Step 2.  In the OSPF/RIP - Parameters Per IP Address  window, specify the
required values.

Step 3.  If available, you can press OSPF parameters .

Step 4.  In the OSPF - Parameters for IP  window, specify the required values
and press OK.

Step 5.  If available, you can press RIP parameters .

Step 6.  In the RIP - Parameters for IP  window, specify the required values and
press OK.

Step 7.  If available, you can press OSPF neighbors (N) .
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Step 8.  In the OSPF - Neighbors  window, specify the required values and press
OK.

 OSPF Areas
You can enable/disable the stub area and authentication functions and define stub
area default cost. You can also modify or delete records in the list of OSPF areas
already configured.

To configure these parameters:

Step 1.  Main window Configuration  menu → OSPF → Areas  → OSPF - Area
Configuration  window.

Step 2.  Specify the required values.

Step 3.  To configure the area ranges, press Ranges .

Step 4.  In the Area Ranges  window, specify the required values.

OSPF Imported and Default Routes
You can enable/disable various 'import' functions including static routes, RIP routes,
BGP routes, direct routes and subnetwork routes. You can also define parameters
such as network IP address and default route cost.

To configure these parameters: Main window Configuration  menu → OSPF →
Imported/default routes  → OSPF - Imported/Default Routes  window

OSPF Virtual Links
You define the neighbor IP addresses and interval timers including
retransmit/transmit, and dead router interval. You can also modify or delete records
in the list of OSPF virtual links already configured.

To configure these parameters: Main window Configuration  menu → OSPF →
Virtual links  → OSPF - Virtual Links  window
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Configuring RIP Parameters

Figure 12-3. RIP Configuration Menu

RIP General Parameters
You can enable/disable RIP and define the 'originate default route' parameters.
You can also modify or delete records in the list of route acceptance network
addresses.

To configure these parameters: Main window Configuration  menu → RIP →
General  → RIP - General Parameters  window

RIP Parameters for each IP Address
You can select an IP address in the list and specify whether you want to configure
OSPF or RIP.

To configure these parameters:

Step 1.  Main window Configuration  menu → RIP →
Parameters per IP address

Step 2.  In the OSPF/RIP - Parameters Per IP Address  window, specify the
required parameters.

Step 3.  To configure addition RIP parameters, press RIP parameters .
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Configuring BGP Parameters

Figure 12-4. BGP Configuration Menu

BGP General and Excluded AS Parameters
You can enable/disable the BGP (border gateway protocol) function and define
parameters for AS (autonomous system) number, and TCP segment size. You can
also select the AS to be excluded, and modify or delete records in the list of
excluded AS.

To configure these parameters: Main window Configuration  menu → BGP →
General/excluded AS  → BGP - General Parameters/Excluded AS  window

BGP Receive Policies
You define policy type, matching addresses, IP address/mask, and AS numbers
(origin and adjacent). You can also modify or delete records in the list of BGP
receive policies already configured.

To configure these parameters: Main window Configuration  menu → BGP →
Receive policies  → BGP - Receive Policies  window

BGP Send Polices
You define policy type, matching addresses, IP address/mask, and AS numbers
(origin and adjacent). You can also modify or delete records in the list of BGP
send policies already configured.

To configure these parameters: Main window Configuration  menu → BGP →
Send policies  → BGP - Send Policies  window
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BGP Originate Policies
You define policy type, matching addresses, IP address/mask, and AS numbers
(origin and adjacent). You can also modify or delete records in the list of BGP
originate policies already configured.

To configure these parameters: Main window Configuration  menu → BGP →
Originate policies  → BGP - Originate Policies  windows

 BGP Neighbors
You define parameters for IP address, AS number, TCP segment, and hold and
connect timers. You can also modify or delete records in the list of BGP neighbors
already configured.

To configure these parameters: Main window Configuration  menu → BGP →
Neighbors  → BGP - Neighbors  window

BGP Aggregate Routes
You define the IP address and subnetwork mask for an aggregate route. You can
also modify or delete records in the list of aggregate route already defined.

To configure these parameters: Main window Configuration  menu → BGP →
Aggregate routes  → BGP - Aggregate Routes  window

Configuring ARP Parameters

 ARP Parameters
You enable/disable ARP net routing, ARP subnetwork routing, and ARP auto
refresh, and you configure ARP entry parameters (port, remote IP address, and
remote MAC address). You can also modify or delete records in the list of ARP
entries already configured.

To configure these parameters: Main window Configuration  menu → ARP →
ARP window
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Configuring SNMP Parameters

 SNMP Parameters
You define the access type, community name and UDP (user datagram protocol)
parameters for SNMP (simple network management protocol). You can also modify
or delete records in the list of SNMP transport information sets already configured.

To configure these parameters: Main window Configuration  menu → SNMP →
SNMP Configuration  window

Make Sure SNMP Access is Enabled When Filtering Packets
To deny outside access to your service LAN when using SNMP, make sure the IP
Access Controls are configured correctly (see Figure 12-5). The following example
shows how to do this:

Figure 12-5. IP Access Controls Window

Step 1.  Leave the default I (permit/inclusive) access control in the list of access
controlled already configured:

I ð.ð.ð.ð ð.ð.ð.ð ð.ð.ð.ð ð.ð.ð.ð

Step 2.  Deny access to all outside hosts by adding an E (deny/exclusive) access
control with the source addresses as 0.0.0.0 0.0.0.0 and the destination
address of you 3746 IP router (for example: 5.5.5.0 255.255.255.0):

E ð.ð.ð.ð ð.ð.ð.ð 5.5.5.ð 255.255.255.ð

Step 3.  Enable access for the SNMP connection between the 3746 and the NNP
with an I with the source and destinations addresses both equal to the
address of your 3746 IP router, in this example:
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I 5.5.5.ð 255.255.255.ð 5.5.5.ð 255.255.255.ð

Step 4.  Enable access for any other IP hosts you to want to have access to your
service LAN.
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Chapter 13. Configuring APPN Parameters

This chapter describes how to configuregeneral and specific APPN parameters
from the main window Configuration  menu (see Figure 13-1) for ports and
stations, and other values such as:

� Network node characteristics
� Management focal points
� Dependent LU servers (DLUSs)

 � Coupler 2080
� Type of 3745/3746
� Adjacent node remote LUs
� COSs (cost of service) and modes
� TGs (transmission groups) and MLTGs.

For additional information about the parameter values and controls in these
windows, press the Help  button in the window.

Configuring General APPN Parameters

Figure 13-1. Configuration Menu

 Coupler
You go to the port configuration window for the selected coupler.

An easier way to go to this window is to simply double-click on the coupler icon.
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Network Nodes, Focal Points, and DLURs
You define values for network identifier and control point name for:

� This Network Node

� Primary network management focal point

� Backup network management focal points

 � Primary DLUS

 � Backup DLUSs.

Also defined is the type of HPR (high performance routing) for this Network Node,
retry timers, and other values.

To configure these parameters: Main window Configuration  menu →
NN/FP/DLUR → Network Node/Focal Point/Dependent LU Requester
Parameters  window

Network Node Characteristics
You define values for cache entries, RAR (route addition resistance), and frequency
of TRS (topology routing services) tree use.

To configure these parameters:

Step 1.  Main window Configuration  menu → NN/FP/DLUR

Step 2.  In the Network Node/Focal Point/Dependent LU Requester
Parameters  window, specify the required values

Step 3.  Press NN characteristics  → Network Node Characteristics  window

Backup Focal Points
You define the network identifier and control point name for a backup focal point.

To configure these parameters:

Step 1.  Main window Configuration  menu → NN/FP/DLUR

Step 2.  In the Network Node/Focal Point/Dependent LU Requester
Parameters  window, specify the required values

Step 3.  Press Backup focal point  → Backup Focal Point Parameters  window

Rapid Transport Protocol/Path Switch Parameters
You define values for sessions and RTP retries and timers.

To configure these parameters:

Step 1.  Main window Configuration  menu → NN/FP/DLUR

Step 2.  In the Network Node/Focal Point/Dependent LU Requester
Parameters  window, specify the required values

Step 3.  Press RTP parameters  → Rapid Transport Protocol (RTP)/Path
Switch Parameters  window
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Coupler/Port 2080 Stations
You specify the type (service processor or NetView Performance Monitor) of
station(s) to be automatically generated.

To configure these parameters: Main window Configuration  menu →
Stations on coupler/port 2080 → Stations on Coupler/Port 2080 window

 3745/3746
You define the type of 3746 for this CCM configuration.

If necessary, you give the identifier of the 3745 attached to the 3746-900 and the
3745 mode of operation.

To configure these parameters: Main window Configuration  menu → 3745/3746
→ 3745/3746 Parameters  window

Frame-relay frame handler set
For information about configuring frame-relay frame handler sets, refer to
“Configuring Frame-Relay Frame Handler Sets” on page 8-11.

Configuring Specific APPN Parameters
The procedures in this section start with: Main window Configuration  menu →
APPN as shown in Figure 13-2.

Figure 13-2. APPN Configuration Menu
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Adjacent Node Remote LUs
You specify the remote LU and adjacent LEN node. You can also modify or delete
LUs in the list of remote LUs already configured.

To configure these LU/LENs:

Main window Configuration  menu → APPN → Adjacent Node Remote LUs  →
Adjacent Node - Remote LUs  window

Session Mode Classes of Service
You specify the mode name and its class of service (COS). You can also modify
or delete mode COSs in the list of modes already configured.

To configure the modes:

Main window Configuration  menu → APPN → Mode/COS  → Mode
Configuration  window

Note:  For information about the class of service parameters, refer to:

� 3745 Communication Controller Models, 3746 Nways Multiprotocol Controller
Models 900 and 950: Planning Guide, GA33-0457

� CCM online help.

Classes of Service
You specify mode and COS names and transmission priorities. You can also
modify or delete items in the lists of modes and COSs already configured.

To configure the modes and COSs:

Step 1.  Main window Configuration  menu → APPN → Mode/COS

Step 2.  In the Mode Configuration  window, specify the required values

Step 3.  Press Configure COS  → Class of Service Configuration  window

 Node Rows
You specify values for weight, RAR (route addition resistance), and congestion.
You can also modify or delete from the list of node rows already configured.

To configure the node rows:

Step 1.  Main window Configuration  menu → APPN → Mode/COS

Step 2.  In the Mode Configuration  window, specify the required values and
press Configure COS

Step 3.  In the Class of Service Configuration  window, specify the required
values and press Node rows  → Node Row Configuration  window
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Transmission Group Rows
You specify values for weight, propagation, security, EC (effective capacity), RCPB
(relative cost per byte), and RCPUT (relative cost per unit of time). You can also
modify or delete TG rows in the list of TG rows already configured.

To configure the TG Rows:

Step 1.  Main window Configuration  menu → APPN → Mode/COS

Step 2.  In the Mode Configuration  window, specify the required values and
press Configure COS

Step 3.  In the Class of Service Configuration  window, specify the required
values and press TG Node rows  → Transmission Group Row
Configuration  window

Multilink Transmission Group
You define the MLTG name and transmission group number. You can also modify
or delete the MLTGs in the list of MLTGs already configured.

To configure the MLTGs:

Main window Configuration  menu → APPN → MLTG → Multilink Transmission
Group Configuration  window

Specifying Multilink Transmission Group Stations
You specify which stations are to be added to or removed from a MLTG.

To add or remove stations:

Step 1.  Main window Configuration  menu → APPN → MLTG

Step 2.  In the Multilink Transmission Group Configuration  window, specify the
required values and press Stations  → Stations Selection  window
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 Part 3. Resource Management
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Chapter 14. Dynamic Activation and How It Affects Your
Network

This chapter describes:

� How to dynamically activate resources in a modified active configuration

� Possible unexpected results when using dynamic activation.

Notes:

1. Information about actual configuration parameter values is not covered (refer to
the CCM online help for parameter descriptions, valid values, and rules for
use).

2. When running the stand-alone CCM, since there is no 3746 connected, there is
nothing to manage and the procedures explained in this chapter are not
available .

Dynamically Activating Modifications to a Configuration while Saving
When you start to save the active configuration, after modifying it, you are asked if
you want to immediately update the active resources affected by the modifications.
Then, you are asked whether you want to immediately activate these resources.

 Important... 

 

� When changes are dynamically activated, most network traffic is
not affected by APPN, IP, and SNA/subarea modifications.

However, dynamic activation of certain resources can have a
major effect on network operation, because a re-IML or VTAM
deactivation of resources may have to be performed. You
should be aware of the information in “Network Traffic Disruption
and Dynamic Activation” on page 14-2 before using dynamic
activation.

� Modifications made to the network node (NN/FP/DLUR
parameters), a LEN, Mode, or COS cannot be dynamically
activated. The CP must be stopped and restarted to take these
changes into account, which is disruptive for all APPN and IP
traffic.

� Choosing dynamic activation after only making modifications to
the MAE configuration restarts the IP CP: all IP router traffic (in
the 3746 and MAE) is disrupted. This is true if the resources
affected by the modifications are not IP resources. Otherwise
(that is if only MAE IP resources have been modified), the
dynamic activation results in the MAE re-IML only.

� Modification of a non-active configuration does not affect the
network traffic. The changes you make to the non-active
configuration are only applied when it is activated.
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Network Traffic Disruption and Dynamic Activation
The tables in this section show the effect on network traffic of viewing, adding, modifying, or deleting
network resources.

 Important 

When you save the active configuration, if you dynamically activate the modifications you
have just made in your configuration, you can disrupt network traffic.

Restarting the IP CP (router) restarts the whole MAE (IP and APPN traffic).

Viewing a Resource

 Important... 

When you finish viewing a 3746 resource of the active configuration, click on Cancel . Don't
use OK.

If you use OK in certain windows, the resources related the parameters in the window are
marked as needing to be re-IMLed, even though you did not change a single thing in the
window. Then when you dynamically activate changes that you do want to make, There
may be unexpected traffic disruptions because resources that you did not change are
re-IMLed.

All 3746 APPN and IP resources related to the following parameters can be disrupted by
using OK even if they are only viewed:

� APPN parameters in port and station configuration windows

 � DLC parameters

� Parameters in the following windows:

– Frame-Relay - Default DLCI

– Frame-Relay CIR - BRS

To summarize:  

� In the 3746 (non-MAE) configuration, use only the Cancel  button to close windows
when you navigate inside CCM to view your configuration.

� In the MAE configuration, this “OK” problem does not exist.
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Adding a Resource When a new resource is created, normally it is not disruptive for any of
preexisting resources. In Table 14-1 are the two groups of parameters that are exceptions to this rule.

Table 14-1. Network Traffic Disruption - Adding a Resource

Network(s) DLC Added Resources Result

APPN,
SNA/subarea

All DLCs 'Frame Relay DLCI/CIR'
parameters

 

MAE IP parameters

MAE other parameters

Disruptive for the associated IP
port, if it exists

If there is no associated IP port,
this is disruptive for APPN ports
and their resources

Disruptive for all IP resources, the
IP router is restarted. Disruptive
for all MAE resources.

Disruptive for all MAE resources,
the MAE is restarted.

IP All DLCs All resources Disruptive for all IP resources, the
IP router is restarted

Modifying a Resource

Table 14-2 (Page 1 of 3). Network Traffic Disruption - Modifying a Resource

Network(s) DLC Modified Resources/Parameters Result

All networks All DLCs 'Network' parameter (sharing) on a
port/host link/DLCI

MAE IP parameters

MAE other parameters

� Disruptive for all APPN
concerned resources and their
resources if modified from an
APPN network to a non-APPN
network

� Non-disruptive if modified from
an IP network to a shared
network

� If modified from a non-IP
network to an IP network, it is
disruptive for all IP resources,
the IP router is restarted

Disruptive for all IP resources,
the IP router is restarted.
Disruptive for all MAE
resources.

Disruptive for all MAE
resources, the MAE is
restarted.
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Table 14-2 (Page 2 of 3). Network Traffic Disruption - Modifying a Resource

Network(s) DLC Modified Resources/Parameters Result

APPN/IP All DLCs
except ESCON

1. APPN parameters in port and
station configuration windows

2. IP specific parameters of all
resources

3. Common parameters of all
resources,

except for:
'Frame Relay DLCI/CIR'
parameters

1. Disruptive for all APPN
concerned resources and their
resources

2. Disruptive for all IP resources,
the IP router is restarted

3. Disruptive for all APPN
concerned resources and their
resources, disruptive for all IP
resources, the IP router is
restarted

Disruptive for the associated IP
port, if it exists.

If there is no associated IP
port, this is disruptive for
APPN ports and their
resources

APPN ESCON ESCON port,

except for:

1. 'Fiber status' parameter

 2. 'ESCD' parameters

Disruptive for concerned APPN
ESCON port and its resources

1. Disruptive for all resources of
the concerned ESCON
processor if modified from
'Enable' to another status

 2. Non-disruptive

IP ESCON ESCON port,

except for:

1. 'Fiber status' parameter

 2. 'Automatic reactivation'
parameter

 3. 'ESCD' parameters

Disruptive for all IP resources, the
IP router is restarted

1. Disruptive for all resources of
the concerned ESCON
processor, if modified from
'Enable' to another status

2. Disruptive for concerned IP
ESCON port and its resources

 3. Non-disruptive

APPN and IP ESCON 1. 'Host link name' parameter

 2. 'HLA' and/or
'Partition number' parameters

3. Other ESCON host link
parameters

1. Disruptive for concerned
APPN/IP ESCON host link and
its resources

2. Disruptive for all resources of
the concerned ESCON
processor (re-IML)

 3. Non-disruptive

APPN ESCON ESCON station Disruptive for concerned APPN
ESCON stations
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Table 14-2 (Page 3 of 3). Network Traffic Disruption - Modifying a Resource

Network(s) DLC Modified Resources/Parameters Result

IP ESCON ESCON station parameters,

except for:
'IP address/subnet mask'
parameters

Disruptive for concerned IP
ESCON station

Disruptive for all IP resources, the
IP router is restarted

SNA/subarea ESCON ESCON port,

except for:
'Fiber status' parameter

Non-disruptive

Disruptive for all resources of the
concerned ESCON processor if
modified from 'Enable' to another
status

SNA/subarea ESCON ESCON host link,

except for:
'HLA' and/or 'Partition number'
parameters

Non-disruptive

Disruptive for all resources of the
concerned ESCON processor
(re-IML)

SNA/subarea ESCON ESCON station,

except for:
'PU type', 'Unit address' and/or 'IPL
through that station' parameters

Non-disruptive

Disruptive for the concerned
SNA/subarea station (manual
VTAM deactivation needed)
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Deleting a Resource

Table 14-3. Network Traffic Disruption - Deleting a Resource

Network DLC Deleted Resources Result

APPN All DLCs
except ESCON

All resources,

except for:
'Frame-relay DLCI/CIR parameters

 

MAE IP parameters

MAE other parameters

Disruptive for all concerned
resources and their resources.

Disruptive for the associated IP
port, if it exists.

If there is no associated IP port,
this is disruptive for APPN ports
and their resources

Disruptive for all IP resources, the
IP router is restarted. Disruptive
for all MAE resources.

Disruptive for all MAE resources,
the MAE is restarted.

APPN and
SNA/subarea

ESCON ESCON port or host link Disruptive for all resources of the
concerned ESCON processor
(re-IML)

APPN and
SNA/subarea

ESCON ESCON station Disruptive for concerned ESCON
stations

IP All DLCs,
except ESCON

All resources Disruptive for all IP resources, the
IP router is restarted

IP ESCON ESCON port or host link Disruptive for all IP resources, the
IP router is restarted and is
disruptive for all resources of the
concerned ESCON processor
(re-IML)

IP ESCON ESCON station Disruptive for all IP resources, the
IP router is restarted and is
disruptive for all resources of the
concerned ESCON processor
(re-IML)
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 Chapter 15. Resource Management

This chapter describes how to view and manage (see the menu in Figure 15-1)
non-MAE:

� Filters for resource management

� Ports (manage and view information about)

� Stations (manage and view information about)

� Sessions (view information about)

� Processor- or port-level IP resources.

No MAE resources can be managed with the functions described in this chapter.

Figure 15-1. Operations Menu in Ports Management Window

Notes:

1. Information about actual configuration parameter values is not covered (refer to
the CCM online help for parameter descriptions, valid values, and rules for
use).

2. When running the stand-alone CCM, since there is no 3746 connected, there is
nothing to manage and the procedures explained in this chapter are not
available .

 Copyright IBM Corp. 1996, 1998  15-1



  
 

Management Using Resource Filters
This section explains the first two item in the Management  menu of the main CCM
window (see Figure 15-1 on page 15-1):

Manage all node resources
Selecting this choice displays, in the appropriate resource management
window (for ports, stations, or sessions), all  the resources of the chosen
type defined on all the couplers installed in the network node.

Manage resources with filter
Selecting this choice lets you limit the number of resources displayed by
filtering the resources according to port number (address), port name,
station name, and partner LU name.

For example, if you want to look at session information, the Session
Management Filters  window is opened (see Figure 15-2).

Figure 15-2. Session Management Filters Window

In this window, you can limit the sessions to those contained in one or a
limited range of:

� Stations, using the station name

� Session partner LU names.

15-2 3746-9X0: CCM User's Guide  



  
 

 Managing Ports
The management tasks that can be performed include:

� Displaying a list of configured ports
� Displaying the resources on a selected port
� Viewing details of a port
� Activating or deactivating ports.

Displaying a List of Configured Ports
You can display the list of the ports configured for the controller. From this list the
ports management tasks can be performed.

To display the port list (see Figure 15-3): Main window Management  menu →
Ports

Figure 15-3. Ports Management Window

Displaying the Resources on a Selected Port
From the list of ports, you can display the list of the stations available for a specific
port.

To display the stations on a port:

Step 1.  Main window Management  menu → Ports

Step 2.  Double click on the desired port.
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 Note... 

All the station management functions are available from the window showing
the stations list associated to a specific port.

Viewing Details of a Port
You can display the configuration details for a selected port. The details include
the parameter values specified during configuration and the values automatically
generated by the CCM during network operation.

To view the details of a port:

Step 1.  Main window Management  menu → Ports

Step 2.  Select the port you want.

Step 3.  Operations  menu → Details  (see Figure 15-4).

Activating and Deactivating Ports
You can activate or deactivate ports as required (see Figure 15-4).

Figure 15-4. Operations Menu for APPN Ports Management

Port activation is a process that loads code and runs tests in order to make the port
available for use. When the port is deactivated, it is no longer available for
providing network services.

Ports can be deactivated normally, or by forcing the deactivation.
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A normally deactivated port is deactivated if traffic has stopped flowing through it
and its associated resources. Sessions are first deactivated, then the stations and
finally the ports.

A force-deactivated port is deactivated while traffic is flowing through it and its
associated resources, regardless of the status of its associated resources. This is
done if, for example, a port has not been deactivated within a reasonable time after
attempting a normal deactivation, or if a port must be immediately deactivated for a
specific reason.

When you activate or deactivate a resource, you receive a message after the
command completion. This message indicates whether or not the command has
been successfully performed and completed. In case of an error, you get a return
code. Use SMPR for problem determination.

Activating/Deactivating an IP Resource...

See “IP Resource Status” on page 15-7.

Activating a Port
To activate a port:

Step 1.  Main window Management  menu → Ports

Step 2.  Select the port you want to activate.

Step 3.  Operations  menu → Activate selected resource

Deactivating a Port Normally
To deactivate a port normally

Step 1.  Main window Management  menu → Ports

Step 2.  Select the port you want to activate.

Step 3.  Operations  menu → Deactivate selected resource (normal mode)

Forcing the Deactivation of a Port
 Be careful...

When you deactivate a port in forced mode, you may lose data in
transit, since the port and its associated resources are deactivated
without waiting for all of their activity to cease.

To force the deactivation of a port:

Step 1.  Main window Management  menu → Ports

Step 2.  Select the port you want to activate.

Step 3.  Operations  menu → Deactivate selected resource (forced mode)
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Activating all Listed Ports
Before you run the command...

Activating a large number of ports may take some time, however the
command can be cancelled from the system menu icon, by selecting
Close .

To activate all listed ports:

Main window Management  menu → Ports  → Operations  menu → Activate
listed ports

Deactivating all Ports in Normal Mode
Before you run the command...

Deactivating a large number of ports may take some time, however,
the command can be cancelled from the system menu icon, by
selecting Close .

Before doing this, scroll vertically through the list of ports, to display
the ports not originally displayed and to check whether you really
want to deactivate them all.

To deactivate all listed ports:

Main window Management  menu → Ports  → Operations  menu → Deactivate
listed resources (normal mode)

Deactivating all Ports in Forced Mode
 Be careful...

When you deactivate a port in the forced mode, you may lose data
in transit, since the port and its associated resources are deactivated
without waiting for all of their activity to cease.

Before you start deactivating all ports, use the vertical scrolling bars
to display the items that can be displayed in the window, and check
if you really want to deactivate all  the ports.

Deactivating a large number of ports is time-consuming. However,
this command can be cancelled from the system menu icon, by
selecting the Close  option.

To force the deactivation of all ports:

1. Main window Management  menu → Ports

2. Operations  menu → Deactivate listed resources (forced mode)

15-6 3746-9X0: CCM User's Guide  



  
 

IP Resource Status
IP resource activation is a two-stage process that runs the activate  command (a
generic management command), and the test  command (an IP command). The
DLC configuration of the IP resource is activated, and then the IP resource in the
processor is activated.

The Activate  and Test  commands are combined into a single CCM command.

IP resource deactivation also has two stages, the disable  command and the
deactivate  command. The IP resource is disabled in the processor, and then the
DLC configuration of the IP resource is deactivated.

The Deactivate  and Disable  commands are also combined into CCM commands.

MOSS-E IP Commands
You can use the IP commands  function from the MOSS-E Network Node
processor (NNP) menu  to issue the TEST or DISABLE  command.

If you issue the TEST or DISABLE  command, the resource status changes.

Possible IP Resource Statuses
An IP resource can have one of the following statuses:

Active/up The activate  has been issued from the CCM and the
resource is ready for operation.

Active/disabled The resource was active and the disable  command has
been issued via TELNET. The resource is not ready for
operation.

Inactive/testing The resource was inactive and the test  command has been
issued via TELNET. The resource is not ready for operation.

Inactive/Disabled The deactivate  command has been issued from the CCM.

Note:  Active/testing  and inactive/up  are not valid statuses.
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Table 15-1 shows the changes in status that result from the issuing of these
commands.

Table 15-1. Post-Command Status

Command issued

Pre-Command Status

Active/up Active/Disabled Inactive/Testing Inactive/Disabled

Test – Active/Up – Inactive/Testing

Disable Active/disabled – – –

Activate – Active/up Active/up Active/up

Deactivate Inactive/Disabled Inactive/Disabled – –

Notes: 

1. A dash (-) indicates that the status remains unchanged.

2. Using CCM, you can only activate and deactivate an IP resource, even though the commands Activate  and
Deactivate  are linked to Test  and Disable

3. Use TELNET to issue the commands TEST and DISABLE

Here are some examples:

If you issue the command DISABLE  via TELNET for a resource which is active/up,
the resource status becomes active/disabled. In this situation, the DLC
configuration is still active, but the IP data is no longer active, and the resource is
no longer ready for operation.

If you issue the command TEST via TELNET for a resource which is
active/disabled, the resource status becomes active/up. In this situation, the DLC
configuration which was already active, remains active, and the IP data has been
activated through the Test  command. The resource, therefore, becomes ready for
operation.
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 Managing Stations
The station management tasks that can be performed with the CCM include:

� Displaying a list of configured stations
� Displaying a list of sessions for a selected station
� Viewing the details of a station
� Activating and deactivating stations.

 Note... 

The station management tasks can be accessed from a window containing a list
of stations associated with a specific port.

Displaying a List of Configured Stations
You can display all of the stations handled by the controller to perform the station
management tasks.

To display the stations:

Main window Management  menu → Stations  → Station Management  window
(see Figure 15-5)

Figure 15-5. APPN Stations Information Display Window
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Displaying a List of Sessions for a Selected Station
Use this function to display the sessions available for a station.

To display the sessions for a station:

Step 1.  Main window Management  menu → Stations  → Station Management
window

Step 2.  Double click on the desired station to display the sessions activated for it.

 Note... 

You can display details about a specific session from the window showing the
sessions activated for a specific station.

Viewing the Details of a Station
You can display the configuration details for a selected station. The details include
the currently configured parameter values and the values automatically generated
by the CCM during network operation.

To display details about a station:

Step 1.  Main window Management  menu → Stations  → Station Management
window

Step 2.  Double click on the desired station

Step 3.  Operations  menu → Details

Activating and Deactivating Stations
You can activate or deactivate stations as required (see Figure 15-4 on
page 15-4).

Station activation is a process that loads code and runs tests in order to make the
station available for use. When the station is deactivated, it is no longer available
for providing network services.

Stations can be deactivated normally, or by forcing the deactivation.

A normally deactivated station is deactivated if traffic has stopped flowing through it
and its associated resources. Sessions are first deactivated, then the stations.

A force-deactivated station is deactivated while traffic is flowing through it and its
associated resources, regardless of the status of its associated resources. This is
done if, for example, a station has not been deactivated within a reasonable time
after attempting a normal deactivation, or if a station must be immediately
deactivated for a specific reason.

When you activate or deactivate a resource, you receive a message after the
command completion. This message indicates whether or not the command has
been successfully performed and completed. In case of an error, you get a return
code. Use SMPR for problem determination.
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Activating a Station
To activate a station:

Step 1.  Main window Management  menu → Stations

Step 2.  Select the station you want to deactivate.

Step 3.  Operations  menu → Activate selected resource

Deactivating a Station Normally
To deactivate a station normally:

Step 1.  Main window Management  menu → Stations

Step 2.  Select the station you want to deactivate.

Step 3.  Operations  menu → Deactivate selected resource (normal mode)

Forcing the Deactivation of a Station
 Be careful...

When you deactivate a station in forced mode, you may lose data in
transit, since the station and its associated resources are deactivated
without waiting for all of their activity to cease.

To force the deactivation of a station:

Step 1.  Main window Management  menu → Stations

Step 2.  Select the station you want to deactivate.

Step 3.  Operations  menu → Deactivate selected resource (forced mode)

Activating all Listed Stations
Before you run the command...

Activating a large number of stations may take some time, however,
the command can be cancelled from the system menu icon, by
selecting Close .

To activate all listed stations:

Main window Management  menu → Stations  → Operations  menu → Activate
listed stations
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Deactivating all Stations Normally
Before you run the command...

Deactivating a large number of stations may take some time,
however the command can be cancelled from the system menu icon,
by selecting Close .

Before doing this, scroll though the list to view all stations and to
check whether or not you really want to deactivate all stations.

To deactivate all stations normally:

Main window Management  menu → Stations  → Operations  menu → Deactivate
listed resources (normal mode)

Forcing the Deactivation of all Stations
 Be careful...

When you deactivate a station in the forced mode, you may lose
data in transit, since the station and its associated resources are
deactivated without waiting for all of their activity to cease.

Before you start deactivating all stations, use the vertical scrolling
bars to display the items that can be displayed in the window, and
check if you really want to deactivate all  stations.

Deactivating a large number of stations is time-consuming.
However, this command can be cancelled from the system menu
icon, by selecting the Close  option.

To force the deactivation of all stations:

1. Main window Management  menu → Stations

2. Operations  menu → Deactivate listed resources (forced mode)
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Displaying Information about Sessions
You can display information about the CP-CP and LU-LU sessions currently routed
through the network node.

To display sessions information:

Step 1.  Main window Management  menu → Non-intermediate sessions  →
Ports Management  window (see Figure 15-6).

Figure 15-6. Sessions Information Display

Step 2.  Double click on the desired session.

Step 3.  Operations  menu → Details

Step 4.  Details about the selected session are displayed in the CCM IP Results
Display  (see Figure 15-8 on page 15-15).
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IP Specific Port/Processor Commands
This section explains how to issue IP port-level or processor-level management
commands to view information about ports or processors and to clear certain
memory areas.

Notes:

1. For the overall, node-level commands, refer to Chapter 17, “Managing IP
Router Data” on page 17-1.

2. The CCM and Telnet commands given in this section cannot be used for the
MAE. MAE IP management is only done through Telnet, refer to either:

� 3746 Nways Multiprotocol Controller Model 950: User's Guide, SA33-0356.

� 3745 Communication Controller Mosels A, 3746 Nways Multiprotocol
Controller Model 900: Basic Operations Guide, SA33-0177.

The port-level or processor-level management commands can be issued in two
ways:

1. By sending a command using the MOSS-E TELNET console, refer to the
3746-950  User's Guide, SA33-0356.

The equivalent TELNET command is given for each CCM command. Most of
the time, the command is issued by selecting a cascaded menu item: the CCM
automatically adds any necessary parameters to the command.

Note:  Certain command ask you for additional information. For example, if
the command must be issued for a specific resource by its address, name, or
number.

2. By using the CCM:

a. Main window Management  menu → Ports

b. Double-click a port in the Ports Management  window → CCM
Management  window

c. Select the level (port or processor) of the command(s) that you want to use
by selecting either one of the first two IP specifics  menu options (see
Figure 15-7 on page 15-15):

On selected port
When this option is selected, only commands that can be issued
on the port-level are available in the IP specifics  menu.

On processor of selected port
When this option is selected, the commands act globally on the
port's processor, that is, for all the ports on all the couplers
attached to the processor.

d. Use the IP specifics  menu to issue a command.
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Figure 15-7. Example IP Port Management Menus

Available Commands Depend on IP Resource DLC
The choices available in the IP specifics  menu and its cascaded sub-menus vary
depending on the DLC (token-ring, frame-relay, X.25, or ESCON) of the resource
selected as a target for the IP commands.

CCM IP Results Display
If information is generated as the result of a command being issued, it is displayed
by CCM in the CCM IP Results Display  window, see Figure 15-8.

Figure 15-8. Example CCM IP Results Display

The Options  menu lets you:

Search You can search for a character string currently in the display (the string
need not be visible at the time of the search).

Clear You can delete all the information currently in the display.
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Buffer Use and Size
To view information about the packet buffer usage and size at the port or processor
level, you can issue either:

� TELNET command: GWCON BUFFER

� CCM command: CCM Management  menu → IP specifics  → Buffer

Protocol and Port Configurations
To view information (DLC type and status) about the ports configured on the
processor, you can issue either:

� TELNET command: GWCON CONFIGURATION

� CCM command: CCM Management  menu → IP specifics  → Configuration

Issuing this command for the 2080 coupler lets you view the whole 3746
configuration.

ESCON and Token-Ring Port Dump
To view an ESCON (line status, traffic statistics) and token-ring (MAC address and,
if source routing is used, RIF information) port dump, you can issue either:

� TELNET command: NET DUMP

� CCM command: CCM Management  menu → IP specifics  → Dump

Current Processor Memory Use
To view information about current processor memory usage, and buffers, you can
issue either:

� TELNET command: GWCON MEMORY

� CCM command: CCM Management  menu → IP specifics  → Memory

Port Queue Length
To view information about the input and output queues (number of buffers and
queue length) at the port or processor level, you can issue either:

� TELNET command: GWCON QUEUE

� CCM command: CCM Management  menu → IP specifics  → Queue
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All Parameters of a X.25 Port
To view information about the X.25 port parameters at the packet, frame, and
physical levels, you can issue either:

� TELNET command: NET PARAMETERS ALL

� CCM command: CCM Management  menu → IP specifics  → Parameters  →
All

This command is only available for X.25 IP ports.

For more information, refer to “X.25 Physical Level Port Parameters,” “X.25 Frame
Level Port Parameters,” and  “X.25 Packet Level Port Parameters.”

X.25 Physical Level Port Parameters
To view information about the X.25 port parameters at the physical level (interface
type, maximum frame size, type of clocking, and others), you can issue either:

� TELNET command: NET PARAMETERS PHYSICAL

� CCM command: CCM Management  menu → IP specifics  → Parameters  →
Physical

This command is only available for X.25 IP ports.

X.25 Frame Level Port Parameters
To view information about the X.25 port parameters at the frame level (maximum
frame and window size, the T1, T2, N1, and disconnect timers, and others), you
can issue either:

� TELNET command: NET PARAMETERS FRAME

� CCM command: CCM Management  menu → IP specifics  → Parameters  →
Frame

This command is only available for X.25 IP ports.

X.25 Packet Level Port Parameters
To view information about the X.25 port parameters at the packet level (default and
maximum packet size, various timers, number of logical circuits, and others), you
can issue either:

� TELNET command: NET PARAMETERS PACKET

� CCM command: CCM Management  menu → IP specifics  → Parameters  →
Packet

This command is only available for X.25 IP ports.

 Error Information
To view statistics about the errors (number of packets discarded or that were
defective) at the port or processor level, you can issue either:

� TELNET command: GWCON ERROR

� CCM command: CCM Management  menu → IP specifics  → Error

  Chapter 15. Resource Management 15-17



  
 

 Interface Information
To view statistics about the number of passed and failed self-tests and the number
of maintenance failures at the port or processor level, you can issue either:

� TELNET command: GWCON INTERFACE

� CCM command: CCM Management  menu → IP specifics  → Statistics  →
Interface

All X.25 Port Statistics
To view all the X.25 counters (packet, frame, and physical levels), you can issue
either:

� TELNET command: NET STATISTICS ALL

� CCM command: CCM Management  menu → IP specifics  → Statistics  → All

For more information, refer to “X.25 Physical Level Port Statistics,” “X.25 Frame
Level Port Statistics,” and  “X.25 Packet Level Port Statistics.”

X.25 Physical Level Port Statistics
To view the X.25 physical layer counters and information (received and transmitted
bytes, cable information, frame error counters, and others), you can issue either:

� TELNET command: NET STATISTICS PHYSICAL

� CCM command: CCM Management  menu → IP specifics  → Statistics  →
Physical

X.25 Frame Level Port Statistics
To view the X.25 frame level counters (number of received and transmitted frames
of each type, number of timeouts for the T1, T2, N1, and disconnect timers, and
others), you can issue either:

� TELNET command: NET STATISTICS FRAME

� CCM command: CCM Management  menu → IP specifics  → Statistics  →
Frame

X.25 Packet Level Port Statistics
To view the X.25 packet level counters (number of received and transmitted
packets of each type and others), you can issue either:

� TELNET command: NET STATISTICS PACKET

� CCM command: CCM Management  menu → IP specifics  → Statistics  →
Packet

15-18 3746-9X0: CCM User's Guide  



  
 

All Statistics for a Serial Line Interface
To view statistics about serial lines (frame-relay circuits, PPP, and X.25) at the port
level, you can issue either:

� TELNET command: NET LIST ALL

� CCM command: CCM Management  menu → IP specifics  → Statistics  →
List  → All

This command is only available for frame-relay, X.25, and PPP ports.

Statistics for a DLCI
To view the statistics for a DLCI, you can issue either:

� TELNET command: NET LIST CIRCUIT

 � CCM command:

1. CCM Management  menu → IP specifics  → Statistics  → List  → Circuit
number

2. Enter a DLCI number and press OK.

This command is only available for frame-relay ports.

 LMI Information
To view information about the LMI (local management interface) for the frame-relay
port, you can issue either:

� TELNET command: NET LIST LMI

� CCM command: CCM Management  menu → IP specifics  → Statistics  →
List  → LMI

This command is only available for frame-relay ports.

Frame-Relay Physical Line Parameters
To view information about the frame-relay physical line parameters for a port, you
can issue either:

� TELNET command: NET LIST LINE PARAMETERS

� CCM command: CCM Management  menu → IP specifics  → Statistics  →
List  → Physical line

This command is only available for frame-relay IP ports.

Frame-Relay COMRATE Parameters
To view information about the frame-relay port parameters, you can issue either:

� TELNET command: NET LIST COMMUNICATION RATE TUNING

� CCM command: CCM Management  menu → IP specifics  → Statistics  →
List  → COMRATE

This command is only available for frame-relay IP ports.
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Frame-Relay DLCI IP Address
To find the IP address of the other end of a frame-relay DLCI, you can issue either:

� TELNET command: NET LIST IARP TABLE

� CCM command: CCM Management  menu → IP specifics  → Statistics  →
List  → IARP table

This command is only available for frame-relay IP ports and is also called the
inverse ARP command.

X.25 PVC Information
To view information about the PVCs (permanent virtual circuits) for the frame-relay
port, you can issue either:

� TELNET command: NET LIST PERMANENT-VIRTUAL-CIRCUITS

� CCM command: CCM Management  menu → IP specifics  → Statistics  →
List  → PVCs

This command is only available for frame-relay ports.

 SVC Information
To view information about the SVCs (switched virtual circuits) for the X.25 or
frame-relay port, you can issue either:

� TELNET command: NET LIST SVCS

� CCM command: CCM Management  menu → IP specifics  → Statistics  →
List  → SVCs

X.25 IP Address Table
To view information about the X.25 IP address table for the port, you can issue
either:

� TELNET command: NET LIST

� CCM command: CCM Management  menu → IP specifics  → Statistics  →
List  → IP-ADDRESS-TABLE

This command is only available for X.25 IP ports.

PPP IP Control Protocol Information
To view control information (state and configuration) about the IP control protocol
for the PPP port, you can issue either:

� TELNET command: NET LIST CONTROL IPCP

� CCM command: CCM Management  menu → IP specifics  → Statistics  →
List  → Control  → IPCP

PPP Link Control Protocol Information
To view control information (state and configuration) about the PPP link control
protocol for the PPP port, you can issue either:

� TELNET command: NET LIST CONTROL LCP

� CCM command: CCM Management  menu → IP specifics  → Statistics  →
List  → Control  → LCP
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PPP Error Statistics
To view error statistics for a PPP port at the port level, you can issue either:

� TELNET command: NET LIST ERRORS

� CCM command: CCM Management  menu → IP specifics  → Statistics  →
List  → Error

PPP Link IP Information
To view information about IP packets over a PPP link at the port level, you can
issue either:

� TELNET command: NET LIST IP

� CCM command: CCM Management  menu → IP specifics  → Statistics  →
List  → IP

PPP IP Control Protocol Statistics
To view IP control protocol statistics (packets received and transmitted) for a PPP
port, you can issue either:

� TELNET command: NET LIST IPCP

� CCM command: CCM Management  menu → IP specifics  → Statistics  →
List  → IPCP

General Port Statistics
To view statistics (type of port(s), number of packets and bytes received and
transmitted) about the port or processor, you can issue either:

� TELNET command: GWCON STATISTICS

� CCM command: CCM Management  menu → IP specifics  → Statistics

 Clearing Statistics
To clear all statistics counters on the port or processor, you can issue either:

� TELNET command: GWCON CLEAR

� CCM command: CCM Management  menu → IP specifics  → Statistics  →
Clear

Router Status Information
To view the status of the all router processes on the processor, you can issue
either:

� TELNET command: OPCON STATUS

� CCM command: CCM Management  menu → IP specifics  → Status

Router Up-Time Statistics
To view router processor statistics (number of restarts and crashes, time since last
reload or restart), you can issue either:

� TELNET command: OPCON UPTIME

� CCM command: CCM Management  menu → IP specifics  → Uptime
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IP Access Controls
To view information about the IP access controls on the processor (enabled or
disabled and exclusive or inclusive for the source and destination networks,
protocols, and ports), you can issue either:

� TELNET command: P_IP ACCESS

� CCM command: CCM Management  menu → IP specifics  → IP commands
→ Access

IP Routing Table Cache
To view the IP routing table cache on the processor, you can issue either:

� TELNET command: P_IP CACHE

� CCM command: CCM Management  menu → IP specifics  → IP commands
→ Cache

 IP Counters
To view statistics in the IP counters for the processor (routing errors, dropped
packets due to congestion, multicast packets, and overflows), you can issue either:

� TELNET command: P_IP COUNTERS

� CCM command: CCM Management  menu → IP specifics  → IP commands
→ Counters

Router IP Addresses
To view the IP addresses and masks for the local processor, you can issue either:

� TELNET command: P_IP INTERFACE

� CCM command: CCM Management  menu → IP specifics  → Statistics  →
Interface

Routing Table Size
routing table size To view the size of the routing table, reassembly buffer, and
routing cache for the processor, you can issue either:

� TELNET command: P_IP SIZES

� CCM command: CCM Management  menu → IP specifics  → IP commands
→ Sizes

Clearing ARP Statistics
To flush the ARP cache for a port, you can issue either:

� TELNET command: P_ARP CLEAR

� CCM command: CCM Management  menu → IP specifics  → ARP commands
→ Clear
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 ARP Cache
To view the ARP cache (MAC address, IP address, and refresh timer) for a port,
you can issue either:

� TELNET command: P_ARP DUMP interface#

� CCM command: CCM Management  menu → IP specifics  → ARP commands
→ Dump ARP routing table

ARP Registered Networks
To view the port type and MAC address of the ports currently registered with ARP,
you can issue either:

� TELNET command: P_ARP HARDWARE

� CCM command: CCM Management  menu → IP specifics  → ARP commands
→ Hardware

ARP Registered Address Protocols
To view ARP information (the port, its protocol, and protocol local address), you
can issue either:

� TELNET command: P_ARP PROTOCOL

� CCM command: CCM Management  menu → IP specifics  → ARP commands
→ Protocol

Statistics about ARP
To view ARP statistics, you can issue either:

� TELNET command: P_ARP STATISTICS

� CCM command: CCM Management  menu → IP specifics  → ARP commands
→ Statistics
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Chapter 16. Viewing Node-Level APPN Information

This chapter explains how to see global information about APPN resources running
on the network node. Figure 16-1 shows the APPN specific cascaded-menu.

Figure 16-1. Example Management Window for APPN

View Details of the APPN Network Topology
You can see the APPN network topology including details about the nodes and the
links that are active and active-on-demand.

To view the topology information: Main window Management  menu → APPN
specifics  → Topology  → Topology Information Display  window

View Details of the Network Nodes
You can see network node information, including details about the service
processor and network node processor.

To view the network node information: Main window Management  menu → APPN
specifics  → Network node  → Network Node Information Display  window

View Details of the Network Directories
You can see information about the network directory, including details of all the LUs
for which the local node 'recognizes' the owning control point, details of the network
node CP name, the number of associated LUs, the name of the owning CP and the
LU entry type.

To view the directory information: Main window Management  menu → APPN
specifics  → Directory  → Directory Information Display  window.
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View Details of the Connection Networks
You can see information about the connection networks.

To view the connection information: Main window Management  menu → APPN
specifics  → Connection networks  → Connection Networks Information
Display  window

View Details of the HRP Connections
You can see information about the high performance routing connections.

To view the HRP connection information: Main window Management  menu →
APPN specifics  → HRP Connections  → HRP Connections Information Display
window

 Aping
You can check the reachability of an APPN resource using this MOSS-E command.
This is similar to the IP PING command.

To use Aping: Main window Management  menu → APPN specifics  → Aping  →
APING MOSS-E window
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Chapter 17. Managing IP Router Data

This chapter explains how to manage IP network resources that are part of the
3746 router (including the MAE), by issuing commands.

These commands can be issued in two ways:

1. By sending a command using the MOSS-E TELNET console, refer to the 3746
Nways Multiprotocol Controller Model 950: User's Guide, SA33-0356.

The equivalent TELNET command is given for each CCM command. Most of
the time, the command is issued by selecting a cascaded menu item: the CCM
automatically adds any necessary parameters to the command.

Note:  Certain command ask you for additional information. For example, if
the command must be issued for a specific resource by its address, name, or
number.

2. Through the IP specifics  cascaded menu from the main window Management
menu (see Figure 17-1).

If information is generated as the result of a command being issued, it is
displayed by CCM in the CCM IP Results Display  window (see Figure 15-7 on
page 15-15).

Figure 17-1. Example of an IP Command Window

These commands are only available if IP resources are in the active configuration.
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General IP Specific Commands

Viewing the Protocol and Interface Configuration
To view details of the protocol and interface configuration for the whole router, you
can issue either:

� TELNET command: GWCON CONFIGURATION

� CCM command: Main window Management  menu → IP specifics  →
Configuration

View (Dump) the Router Routing Table
To perform a dump of the router routing table, you can issue either:

� TELNET command: P_IP DUMP

� CCM command: Main window Management  menu → IP specifics  → Dump
routing table

Verifying the Reachability of a Resource: Ping
This commands checks whether or not a resource is currently reachable. It sends
data packets of a specific size to the remote resource and requests the resource to
send back the same packets as confirmation that it is reachable.

This command can be issued to a resource at a specific destination address, with
no other parameters being defined. Alternatively the command can be issued to a
specific destination address, with additional control values such as the size of the
data packet being used for pinging, or the time to live (TTL) value for the ping
packets.

You can issue either:

� TELNET command: P_IP PING

� CCM command: Main window Management  menu → IP specifics  → Ping  →
Ping  window

To start  pinging, specify the values in the window and press Ping .

To Stop  pinging, return to the Ping  window and press Stop ping .

Restarting the IP Router
To restart the IP router, you can issue either:

� TELNET command: OPCON RESTART

� CCM command: Main window Management  menu → IP specifics  → Restart

Note:  When the IP router is restarted, the MAE is completely (both IP and APPN
traffic) restarted.

17-2 3746-9X0: CCM User's Guide  



  
 

Viewing the Route to a Resource
To view information (next hops, routing characteristics) about the route to a
specified destination address, you can issue either:

� TELNET command: P_IP ROUTE

� CCM command: Main window Management  menu → IP specifics  → Route  →
Route  window

Tracing the Route to a Resource
This command traces the transfer of packets to the specified destination and shows
the entire route, information about the next hops, and the time to get to each
intermediate hop.

To trace the entire route to a specific network resource, you can issue either:

� TELNET command: P_IP TRACEROUTE

� CCM command: Main window Management  menu → IP specifics  →
Traceroute  → Traceroute  window

To start  tracing, specify the values in the window and press Trace .

To Stop  tracing, return to the Traceroute  window and press Stop trace .

IP OSPF Commands

OSPF Link State Advertisement
To view details of a link state advertisement in the OSPF database, you can issue
either:

� TELNET command: P_OSPF ADVERTISEMENT [advertising-router] [area-id]
command

� CCM command: Main window Management  menu → IP specifics  → OSPF →
Advertisement  → OSPF - Advertisement  window

 OSPF Area
To view the statistics and parameters of all the OSPF areas attached to the router,
you can issue either:

� TELNET command: P_OSPF AREA

� CCM command: Main window Management  menu → IP specifics  → OSPF →
Area

OSPF AS-External Information
To view all the AS external advertisements belonging to the OSPF routing domain,
you can issue either:

� TELNET command: P_OSPF AS-EXTERNAL

� CCM command: Main window Management  menu → IP specifics  → OSPF →
AS-External
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OSPF Area Link State Database
To view link state (advertisements) database of a specific OSPF area, you can
issue either:

� TELNET command: P_OSPF DATABASE

� CCM command: Main window Management  menu → IP specifics  → OSPF →
Database  → OSPF - Database  window

OSPF Interface Statistics
To view details of the statistics and parameters for all OSPF interfaces, or a
specific one, you can issue either:

� TELNET command: P_OSPF INTERFACE

� CCM command: Main window Main window Management  window → IP
specifics  → OSPF → Interface  → OSPF - Interface  window

Adding an OSPF Router to a Multicast Group
To add an OSPF router to a multicast group, you can issue either:

� TELNET command: P_OSPF JOIN

� CCM command: Main window Management  menu → IP specifics  → OSPF →
Multicast  → Join  → OSPF - Join Multicast Group Address  window

Removing an OSPF Router from a Multicast Group
To remove an OSPF router from a multicast group, you can issue either:

� TELNET command: P_OSPF LEAVE

� CCM command: Main window Management  menu → IP specifics  → OSPF →
Multicast  → Leave  → OSPF - Leave Multicast Group Address  window

OSPF Multicast Cache
To view all or a specific multicast cache entry, you can issue either:

� TELNET command: P_OSPF MCACHE

� CCM command: Main window Management  menu → IP specifics  → OSPF
→ Multicast  → Mcache  → OSPF - Multicast Cache  window

Router OSPF Membership Groups
To view the group membership of the attached router interfaces, you can issue
either:

� TELNET command: P_OSPF MGROUPS

� CCM command: Main window Management  menu → IP specifics  → OSPF →
Multicast  → Mgroups
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OSPF Multicast Routing Statistics
To view statistics (types of forwarding enabled, datagram counters) about the
multicast routing, you can issue either:

� TELNET command: P_OSPF MSTAT

� CCM command: Main window Management  menu → IP specifics  → OSPF →
Multicast  → Mstat

Details of Active OSPF Neighbors
To view statistics and parameters for all or a specified OSPF neighbor, you can
issue either:

� TELNET command: P_OSPF NEIGHBOR

� CCM command for all neighbors: Main window Management  menu → IP
specifics  → OSPF → Multicast  → Neighbors  → OSPF - Neighbors  window

OSPF Router Routes
To view all the router routes that have been calculated by OSPF, you can issue
either:

� TELNET command: P_OSPF ROUTERS

� CCM command: Main window Management  menu → IP specifics  → OSPF →
Routers

Link State Advertisement Database Statistics
To view the number of link state advertisements (LSAs) in the link state database
(categorized by type), you can issue either:

� TELNET command: P_OSPF SIZE

� CCM command: Main window Management  menu → IP specifics  → OSPF →
SIZE

OSPF Routing Statistics
To view the statistics generated by the OSPF routing protocol, you can issue either:

� TELNET command: P_OSPF STATISTICS

� CCM command: Main window Management  menu → IP specifics  → OSPF →
Statistics

Changing the Cost of an OSPF Interface
You can view and temporarily change the cost of a router OSPF interface. If the
router is restarted or reloaded, the cost of the interface reverts back to its original
configured value.

You can issue either:

� TELNET command: P_OSPF WEIGHT

� CCM command: Main window Management  menu → IP specifics  → OSPF →
Weight  → OSPF - Weight  window
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IP BGP View Commands

BGP Routing Table
You can view (dump) the BGP routing table (network addresses, subnet masks,
advertised to- and advertised from-entries).

This command can be issued to all destinations, a specific destination, or to
destinations advertised or obtained.

You can issue either:

� TELNET command: P_BGP DESTINATIONS

� CCM command: Main window Management  menu → IP specifics  → BGP →
Destinations  → BGP - Destinations  window

Details of Active BGP Neighbors
To view details of all active neighbors, or of a specific neighbor, you can issue
either:

� TELNET command: P_BGP NEIGHBORS

� CCM command: Main window Management  menu → IP specifics  → BGP →
Neighbors  → BGP - Neighbors  window

Path Description Database
To view the paths in the path description database, you can issue either:

� TELNET command: P_BGP PATHS

� CCM command: Main window Management  menu → IP specifics  → BGP →
Paths

Size of the BGP Databases
To view the size of all the BGP databases, you can issue either:

� TELNET command: P_BGP SIZES

� CCM command: Main window Management  menu → IP specifics  → BGP →
Sizes
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 Appendix A. Bibliography

Customer Documentation for the 3746 Model 950

Table A-1 (Page 1 of 2). Customer Documentation for the 3746 Model 950

This customer documentation has the following formats:

B o o k s

O n l i n e B o o k s

and

D i s k e t t e s

Finding Information

3745 Models A and 3746 Books

Starting with engineering change (EC) F12380, all of the books in the 3745
Models A and 3746 library are available on the CD-ROM that contains the
Licensed Internal Code (LIC) for this EC.

Preparing for Operation

GA33-0400 IBM 3745 Communication Controller All Models ñ

IBM 3746 Expansion Unit Model 900
IBM 3746 Nways Multiprotocol Controller Model 950

Safety Information ò

Provides general safety guidelines

Evaluating and Configuring

GA33-0180 IBM 3745 Communication Controller Models A ó

IBM 3746 Nways Multiprotocol Controller
Models 900 and 950

Overview

Gives an overview of connectivity capabilities within SNA, APPN, and IP
networking.

GA33-0457 IBM 3745 Communication Controller Models A ò

IBM 3746 Expansion Unit Model 900
Models 900 and 950

Planning Guide

Planning for:

 � Field upgrades
� Service processor and alert management configuration
� Network integration (NCP, APPN, and IP control)

 � Physical installation.
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Table A-1 (Page 2 of 2). Customer Documentation for the 3746 Model 950

Operating and Testing

SA33-0356 IBM 3746 Nways Multiprotocol Controller
Model 950

User's Guide ò

Explains how to:

� Carry out daily routine operations on Nways controller
� Install, test, and customize the Nways controller after installation
� Configure user's workstations to remotely control the service processor

using:
 – DCAF program

– Telnet client program.

On-line information Controller Configuration and Management Application

Provides a graphical user interface for configuring and managing a 3746
APPN/HPR network node and IP Router, and its resources.
Is also available as a stand-alone application, using an OS/2 workstation.
Defines and explains all the 3746 Network Node and IP Router configuration
parameters through its on-line help.

SH11-3081 IBM 3746 Nways Multiprotocol Controller
Models 900 and 950

Controller Configuration and Management: User's Guide ò

Explains how to use CCM and gives examples of the configuration process.

Managing Problems

On-line information Problem Analysis Guide

An on-line guide to analyze alarms, events, and control panel codes on:

� IBM 3745 Communication Controller Models Aó
� IBM 3746 Nways Multiprotocol Controller Models 900 and 950.

SA33-0175 IBM 3745 Communication Controller Models A ó
IBM 3746 Expansion Unit Model 900
IBM 3746 Nways Multiprotocol Controller Model 950

Alert Reference Guide

Provides information about events or errors reported by alerts for:

� IBM 3745 Communication Controller Models Aó
� IBM 3746 Nways Multiprotocol Controller Models 900 and 950.

ñ Models 130 to 61A.
ò Documentation shipped with the 3746-950
ó 3745 Models 17A to 61A.
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Customer Documentation for the 3745 (Models 210, 310, 410, 610, 21A,
31A, 41A, and 61A), and 3746 (Model 900)

Table A-2 (Page 1 of 4). Customer Documentation for the 3745 Models X10 and X1A, and 3746 Model 900

This customer documentation has the following formats:

B o o k s

O n l i n e B o o k s

a n d

D i s k e t t e s

Books
and

CD-ROM

Finding Information

3745 Models A and 3746 Books

Starting with engineering change (EC) F12380, all of the books in the 3745
Models A and 3746 library are available on the CD-ROM that contains the
Licensed Internal Code (LIC) for this EC.

SA33-0172 IBM 3745 Communication Controller
Models 210 to 61A
IBM 3746 Expansion Unit Model 900

Customer Master Index ñ

Provides references for finding information in the customer documentation
library.

Evaluating and Configuring

GA33-0092 IBM 3745 Communication Controller
Models 210, 310, 410, and 610

Introduction

Gives an introduction of the IBM Models 210 to 610 capabilities.

For Models A refer to the Overview, GA33-0180.

GA33-0180 IBM 3745 Communication Controller Models A ò

IBM 3746 Nways Multiprotocol Controller
Models 900 and 950

Overview

Gives an overview of connectivity capabilities within SNA, APPN, and IP
networking.
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Table A-2 (Page 2 of 4). Customer Documentation for the 3745 Models X10 and X1A, and 3746 Model 900

GA33-0457 IBM 3745 Communication Controller Models A ò

IBM 3746 Expansion Unit Model 900
Models 900 and 950

Planning Guide

Planning for:

 � Field upgrades
� Service processor and alert management configuration
� Network integration (NCP, APPN, and IP control)

 � Physical installation.

Preparing Your Site

GC22-7064 IBM System/360, System/370, 4300 Processor

Input/Output Equipment Installation Manual-Physical Planning
(Including Technical News Letter GN22-5490)

Provides information for physical installation for the 3745 Models 130 to 610.

For 3745 Models A and 3746 Model 900, refer to the Planning Guide,
GA33-0457.

GA33-0127 IBM 3745 Communication Controller
Models 210, 310, 410, and 610

Preparing for Connection

Helps for preparing the 3745 Models 210 to 610 cable installation.

For 3745 Models A refer to the Connection and Integration Guide, SA33-0129.

Preparing for Operation

GA33-0400 IBM 3745 Communication Controller All Models ó

IBM 3746 Nways Multiprotocol Controller
Models 900 and 950

Safety Information ñ

Provides general safety guidelines.

SA33-0129 IBM 3745 Communication Controller All Models ó

IBM 3746 Nways Multiprotocol Controller Model 900

Connection and Integration Guide ñ

Contains information for connecting hardware and integrating network of the
3745 and 3746-900 after installation.

SA33-0416 Line Interface Coupler Type 5 and Type 6
Portable Keypad Display

Migration and Integration Guide

Contains information for moving and testing LIC types 5 and 6.
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Table A-2 (Page 3 of 4). Customer Documentation for the 3745 Models X10 and X1A, and 3746 Model 900

SA33-0158 IBM 3745 Communication Controller All Models ó

IBM 3746 Nways Multiprotocol Controller Model 900

Console Setup Guide ñ

Provides information for:

� Installing local, alternate, or remote consoles for 3745 Models 130 to 610
� Configuring user workstations to remotely control the service processor for

3745 Models A and 3746 Model 900 using:
 – DCAF program

– Telnet Client program.

Customizing Your Control Program

SA33-0178 Guide to Timed IPL and Rename Load Module

Provides VTAM procedures for:

� Scheduling an automatic reload of the 3745
� Getting 3745 load module changes transparent to the operations staff.

Operating and Testing

SA33-0098 IBM 3745 Communication Controller
All Models ô

Basic Operations Guide ñ

Provides instructions for daily routine operations on the 3745 Models 130 to
610.

SA33-0177 IBM 3745 Communication Controller Models A ò

IBM 3746 Nways Multiprotocol Controller Model 900

Basic Operations Guide ñ

Provides instructions for daily routine operations on the 3745 Models 17A to
61A, and 3746 Model 900 operating as an SNA node (using NCP),
APPN/HPR Network Node, and IP Router.

SA33-0097 IBM 3745 Communication Controller
All Models ó

Advanced Operations Guide ñ

Provides instructions for advanced operations and testing, using the 3745
MOSS console.

On-line Information Controller Configuration and Management Application

Provides a graphical user interface for configuring and managing a 3746
APPN/HPR Network Node and IP Router, and its resources.
Is also available as a stand-alone application, using an OS/2 workstation.
Defines and explains all the 3746 Network Node and IP Router configuration
parameters through its online help.
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Table A-2 (Page 4 of 4). Customer Documentation for the 3745 Models X10 and X1A, and 3746 Model 900

SH11-3081 IBM 3746 Nways Multiprotocol Controller
Models 900 and 950

Controller Configuration and Management: User's Guide õ

Explains how to use CCM and gives examples of the configuration process.

Managing Problems

SA33-0096 IBM 3745 Communication Controller
All Models ó

Problem Determination Guide ñ

A guide to perform problem determination on the 3745 Models 130 to 61A.

On-line Information Problem Analysis Guide

An online guide to analyze alarms, events, and control panel codes on:

� IBM 3745 Communication Controller Models Aò
� IBM 3746 Nways Multiprotocol Controller Models 900 and 950.

SA33-0175 IBM 3745 Communication Controller Models A ò

IBM 3746 Expansion Unit Model 900
IBM 3746 Nways Multiprotocol Controller Model 950

Alert Reference Guide

Provides information about events or errors reported by alerts for:

� IBM 3745 Communication Controller Models Aò
� IBM 3746 Nways Multiprotocol Controller Models 900 and 950.

ñ Documentation shipped with the 3745.
ò 3745 Models 17A to 61A.
ó 3745 Models 130 to 61A.
ô Except 3745 Models A.
õ Documentation shipped with the 3746-900.
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Additional Customer Documentation for the 3745 Models 130, 150, 160,
170, and 17A

Table A-3. Additional Customer Documentation for the 3745 Models 130 to 17A

This customer documentation has the following format:

B o o k s

Finding Information

SA33-0142 IBM 3745 Communication Controller
Models 130, 150, 160, 170, and 17A
IBM 3746 Nways Multiprotocol Controller Model 900

Customer Master Index ñ

Provides references for finding information in the customer documentation
library.

Evaluating and Configuring

GA33-0138 IBM 3745 Communication Controller
Models 130, 150, and 170

Introduction

Gives an introduction about the IBM Models 130 to 170 capabilities, including
Model 160.

For Model 17A refer to the Overview, GA33-0180.

Preparing Your Site

GA33-0140 IBM 3745 Communication Controller
Models 130, 150, 160, and 170

Preparing for Connection

Helps for preparing the 3745 Models 130 to 170 cable installation.

For 3745 Model 17A refer to the  Connection and Integration Guide,
SA33-0129.

ñ Documentation shipped with the 3745.
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List of Abbreviations

APPN Advanced Peer-to-Peer Networking

ARP address resolution protocol

AS autonomous system

BGP border gateway protocol

BLPU build logical program unit

BRS bandwidth reservation

CCM Controller Configuration and Management

CCU central control unit

CDF-E configuration data file - extended

CHPID channel path id

CIR committed information rate

COS class of service

CP control point

CUD call user data

DCE data circuit-terminating equipment

DCAF Distributed Console Access Facility

DLC data link control

DLCI data link connection identifier

DLUR dependent logical unit requester

DLUS dependent logical user server

DTE data terminal equipment

EC engineering change

ECA engineering change announcement

EGA ESCON Generation Assistant

EMIF ESCON Multiple Image Facility

ESCC ESCON channel coupler

ESCD ESCON Director

ESCON Enterprise Systems Connection

ESCP ESCON channel processor

FRFH frame-relay frame handler

HCD Hardware Configuration Definition

HPR high performance routing

I/O input or output, input and output

IDF Internet definition file

IML initial microcode load

IOC input/output control

IOCP Input/Output Configuration Program

IP Internet Protocol, internetwork protocol

IPCP 

IPL initial program load

ISDN integrated services digital network

LAN local area network

LAPB link access protocol - balanced

LC logical channel

LCP link control protocol

LCN logical channel number

LEN low entry networking

LIC line interface coupler

LLC logical link control

LMI local management interface

LU logical unit

MAC medium access control

MAE multiaccess enclosure

MB megabype (processor storage)
1MB = 220 (1 048 576 bytes)

MLTG multilink transmission group

MOSS-E maintenance and operator subsystem -
extended

MVS Multiple Virtual Storage

NAK negative acknowledgement

NAU network accessible unit

NCP Network Control Program

NDF network definition file

NNP network node processor

NPA NetView Performance Analyzer

NPI numbering plan identification

NPM Network Performance Monitor

OSPF open shortest path first

PLP packet level protocol

PPP point-to-point protocol

PR/SM processor resource/systems manager

PVC permanent virtual circuit

QLLC qualified logical link control

RAM random access memory

RAR route addition resistance

RCPB relative cost per byte

RCPUT relative cost per unit of time
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RIF routing information field

RIP routing information protocol

RTP rapid transport protocol

SATF shared access transport facility

SBS subset

SDLC synchronous data link control

SNA Systems Network Architecture

SNMP simple network management protocol

SOC sphere of control

SVC switched virtual circuit

TCP transmission control protocol

TG transmission group

TOA type of address

TRP token-ring processor

TRS transmission control protocol

TTL time to live

UDP user datagram protocol

VC virtual circuit

VGA video graphics adapter

VTAM Virtual telecommunications Access
Method
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 Glossary

This glossary explains some of the terms used in this
guide.

A
action bar .  Also known as the menu bar. The area at
the top of the primary window containing selectable
keywords that gives the user access to actions in that
window. When the user selects a keyword on the
action bar, a pull-down menu is displayed.

action bar pull-down menu .  An extension of the
action bar that displays a list of choices related to the
keyword that was selected on the action bar. Also
known as a menu.

assigned focal point .  A focal point where a SOC
(sphere of control) is included, by explicit definition at
the focal point or the SOC node. If a node's inclusion in
the SOC is defined at the focal point, the focal point is
known as an explicit focal point for that SOC node. If a
node's inclusion in the SOC is defined at the SOC
node, the focal point is known as an implicit focal point
for that node.

B
backup focal point .  A focal point that provides
specific management services for a node if
communications with the primary focal point fail. Both
of the assigned focal points (explicit and implicit) and
the default focal points can also have backup
counterparts.

C
Channel Path Identifier .  The address assigned to
each installed channel path of a system which uniquely
identifies that path. The CHPID is “connected” either to
a Host Link Address on an ESCD or directly to an
ESCC (if there is no ESCON Director).

connection network .  A representation within an
APPN network of a shared access transport facility
(SATF), such as a token ring, that allows nodes
identifying their connectivity to the SATF by a common
virtual routing node, to communicate without having
individually defined connections to one another.

D
default focal point .  A focal point that provides
management services for nodes that have not been
assigned a focal point. The set of nodes in the SOC
(sphere of control) of a default focal point is not defined
at the focal point itself, or at the SOC nodes. A default
focal point exchanges management services with all the
network nodes known to it. Only those nodes that have
not established a relationship with another focal point
can accept the request.

E
ESCON Multiple Image Facility .  A host mode that
allows ESCON channels to be shared across PR/SM
logical partitions.

ESCON Channel Coupler .  This is a communication
controller that provides the interface between the
ESCON channel processor (ESCP) and the ESCON
fiber optic cable.

Only one ESCC can be defined for each ESCP. It must
be installed in the leftmost slot of the ESCP.

All ESCCs of the communication controller must be
defined in the same subset.

ESCON Director .  This is a switching device that can
be attached to processors with ESCON channels and to
ESCON control units. It permits dynamic channel link
switching.

Enterprise System Connection. .  A set of IBM
networking communications products that use fiber-optic
technology.

ESCON Channel Processor .  This is a
communications controller that provides the channel
data link control for the ESCON channel adapter.

I
IOCP.  Input/Output Control Program, defines and
controls all the available I/O devices and channel paths.

IPL port .  Initial Program Load port
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L
LEN node .  Low entry networking node. A node that
supports independent LU protocols but which does not
support CP-CP sessions. LEN nodes can be one of the
following:

� A peripheral node attached to a boundary node in a
subarea network

� An end node attached to an APPN network node in
an APPN network

� A peer connected node directly attached to another
LEN node or APPN end node

link station .  1) The hardware and software
components in a node that represent the connection to
an adjacent node over a specific link. For example, if
node A is the primary end of a multipoint line that
connects to three adjacent nodes, node A will have
three link stations representing the connections to the
adjacent nodes.

2) In VTAM, a named resource within an APPN or
subarea node that represents the connection to another
APPN or subarea node which is attached by an APPN
or subarea link. In the resource hierarchy in a subarea
network, the link station is subordinate to the subarea
link.

LU.  Logical unit. A network accessible unit (NAU) that
enables users to access network resources and to
communicate with other users.

LU-LU session .  Logical unit-logical unit session. A
logical connection between two logical units in a
network that provides communication capabilities for
two users.

LU name .  Logical unit name.

M
Medium access control .  The sub-layer of the data
link control layer that supports medium dependent
functions and which uses the services of the physical
layer to provide services to the logical link control (LLC)
sub-layer. The MAC sub-layer includes the process for
determining when a device has access to the
transmission medium.

Maintenance and Operator Subsystem - Extended .
A licensed, internal program which resides on the
service processor's hard disk. It is designed to provide
system maintenance and operation functions for
end-users or IBM service representatives.

N
network identifier .  Part of a network address that
defines the network. The network ID is a 1 to 8 byte
name selected by the user or an 8 byte IBM registered
name that uniquely identifies a specific subnetwork.

network node .  A node that offers a broad range of
end user services. An APPN network node can provide
distributed directory services, optimal routing, session
services and intermediate routing services.

P
port .  An access point for data entry or exit which is
also the representation of a physical connection to the
link hardware.

primary focal point .  The central control point for any
management services element which is responsible for
handling the network management data.

primary window .  The top level window in an
application program that can be minimized or
represented by an icon.

S
Synchronous Data Link Control .  A process that
manages synchronous, code-transparent, serial-by-bit
data transfer over a link connection. Data transmission
can be duplex or half duplex over switched or
nonswitched links. The link connection can be
configured as point-to-point, multipoint or loop.

secondary window .  A window that can be moved and
sized. Secondary windows are always associated with
a primary window.

SNA network .  The part of a user application network
that conforms to the SNA formats and protocols. It
enables reliable transfer of data among end users and
provides protocols for controlling the resources of the
network.

station .  The input or output point of a system that
uses telecommunications facilities; for example, one or
more systems, computers, terminals, devices, and
associated programs at a particular location that can
send or receive data over a telecommunication line.

subarea .  A portion of the SNA network consisting of a
subarea node, attached peripheral nodes, and
associated resources. Within a subarea node, all
network accessible units (NAUs), links, and adjacent
link stations (in attached peripheral or subarea nodes)
that are addressable within the subarea, share a
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common subarea address and have distinct element
addresses.

subset .  The part of an EGA (ESCON Generation
Assistant) output file which is specific to all ESCON
channel adapters on a communications controller. this
information is placed in the EGA .SDS output file.
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